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Introduction
About This Manual

Welcome to pluggo, the never-ending plug-in. This Getting Started manual covers instal-
lation of the program, operation of the interface features common to all pluggo-based 
plug-ins, information about using Plug-in Manager, synchronization, pluggo Modula-
tors, opening other VST plug-ins within pluggo, PluggoBus and automation.

Do you need to read this entire manual? We definitely recommend reading through the 
description of the installation, authorization and registration processes. The rest of this 
manual may cover some material with which you are already familiar. However, it’s pretty 
short and discusses a few things that might not be obvious to the new user. For instance, 
did you know you can undo changes to parameters in pluggo plug-ins? Look in the Plug-
in User Interface chapter for the details.

The documentation assumes that you are familiar with the basic operations of the 
sequencer program you’ll be using to host pluggo plug-ins. We do review a few things 
related to inserting effects in Cubase, Pro Tools, Digital Performer, Logic Audio, Live, 
Peak and Spark, but very little is said about creating or importing audio tracks or using 
audio I/O.

The Pluggo Plug-in Reference Guide, which describes each of the included plug-ins, is in 
electronic format. It’s found in the Pluggo Stuff folder on the root level of the hard disk 
where you installed the software. In addition, all of the included plug-ins contain infor-
mation on their use that you can access interactively. Plug-ins generally come with exam-
ple preset effect programs (when it makes sense), as well as hints and other interactively 
accessible text describing parameters and basic operations.

This manual does not describe how to make your own plug-ins with Max and MSP. The 
Pluggo Installer places plug-in development materials in the Pluggo Stuff folder.

Basic Features of Pluggo

• A lot of plug-ins (over 100 of them)

• The ability to open any plug-in made with the plug-in development tools that are 
part of Max/MSP

• Support for host synchronization in VST 2.0 and MAS applications. With other 
hosts, you can use the PluggoSync feature for synchronization.

• Plug-ins that can send audio and/or control information to each other

• A Plug-in Manager that lets you keep track of enabled and disabled plug-ins

• Modulator plug-ins that control the parameters of other plug-ins

• Instrument plug-ins that respond to sequenced and live MIDI input

• Support for hosting VST plug-ins so that you can use pluggo Modulator plug-ins to 
change their parameters (VST and MAS hosts only)
Introduction 4



                           
System Requirements

pluggo requires:

• A PowerPC Macintosh or Mac OS clone. A 604 or G3 processor running at 150Mhz 
or faster is recommended.

• System 8.6 or later

• A sequencer application that hosts VST, VST 2.0, MAS, or RTAS plug-ins. Pro Tools 
Free is not an officially supported host for RTAS.

• At least 64MB of memory, although the exact amount depends on the system version 
and the host sequencer you’re using.

• At least 55MB of hard disk space

Where to Get Help and Support

If you encounter problems when using pluggo, the following resources are available:

• The Pluggo FAQ document, on-line at 

http://www.cycling74.com/support/questionspl.html

• e-mail to support@cycling74.com

• You may telephone our customer support line at (415) 869-2812

• If you have any questions related to installation and authorization of the software, you 
may telephone our office at (415) 621-5743, generally open from 10AM to 4PM Pacific 
time.

A Little Background Information on Pluggo

pluggo is a runtime shell that uses the Max object-oriented graphical programming envi-
ronment. pluggo’s signal processing capabilities are provided by the MSP audio exten-
sions to Max, published by Cycling ’74. Using Max and MSP in conjunction with pluggo, 
you can write your own audio and MIDI plug-ins.

The authors of Max and MSP are Miller Puckette and David Zicarelli. The pluggo plug-
ins and objects were written in Max/MSP by jhno, Adam Schabtach, David Zicarelli, 
Leslie Stuck, Joshua Kit Clayton, Marc Sirguy, Darwin Grosse, and Gregory Taylor. 
Additional MSP objects for pluggo were written by Richard Dudas, who also drew the 
pluggo character. Plug-in Manager was written by Adam Schabtach. RTAS support was 
by Adam Schabtach. pluggo user interface design by Lilli Wessling Hart and jhno. This 
manual was written by David Zicarelli and Gregory Taylor, with contributions from 
jhno, Darwin Grosse, and Adam Schabtach.

E-mail or telephone technical support is only available to customers who have 
purchased pluggo. If you did not purchase your copy of pluggo directly from 
Cycling ’74, please send in the registration card in your package or register at 
www.cycling74.com/register.
5 Introduction 



                         
Installing Pluggo
Installing pluggo involves two steps. First, running the Pluggo Installer from the CD-
ROM or your software download folder, and second, running the Authorize Pluggo 
application to authorize the software.

What is Going to be Installed?

The Pluggo Installer will put files in the folder containing your sequencer application. 
pluggo has a couple of files that contain the support environment for its plug-ins that are 
placed in the same folder as the sequencer application. The other common files used by 
all pluggo host applications are located in the Max/MSP Runtime Support folder inside 
the Extensions folder. This folder should not be moved or renamed.

Additional support files (or aliases to these files) will be placed in a subfolder of the 
sequencer’s application folder called Pluggo Support.

If you’re installing the MAS version of pluggo, a “stub” plug-in called Pluggo for MAS is 
installed in the Plug-ins folder inside the MOTU folder inside your Extensions folder. 
Unlike other MAS plug-ins you may have, however, the actual pluggo plug-ins themselves 
are not installed here. Instead, they are in a folder called VstPlugIns inside the applica-
tion folder. If you’ll be using pluggo with more than one MAS application, you’ll need to 
install a copy for each application.

If you’re installing the RTAS version of pluggo, a “stub” plug-in called Pluggo-RTAS is 
installed in the Plug-ins folder inside the DAE folder inside your System folder. The 
actual pluggo plug-ins themselves are not installed here. Instead, they are in a folder 
called Pluggo Plug-ins inside the Pro Tools application folder. The installer also creates 
an alias to this folder and puts it inside the DAE folder.

The Plug-in Manager application and additional documentation is placed in a folder 
called Pluggo Stuff.

The Pluggo Installer

When you run the Pluggo Installer, you’ll first see a license agreement covering the soft-
ware and its documentation. Please read the agreement carefully and click Agree if you 
are willing to abide by its terms.

The screen appearing after the license agreement lets you choose between Easy Install 
and Custom Install. In Custom Install, you can selectively exclude certain items from 
being installed. We recommend Easy Install unless you know what you are doing and 
want to re-install a specific file.

If you click Easy Install, you’ll be presented with the dialog box shown below and asked 
to select the application that will host the plug-ins. For example, if you’ll be using pluggo 

You can use Plug-in Manager to move plug-ins from the disabled plug-ins folder 
to the VstPlugIns folder. You can also make “sets” of enabled/disabled plug-ins. 
See the Plug-in Manager chapter of this manual for more information.
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with Cubase, open your Cubase folder and select this application file. The plug-ins and 
support files will be installed in the folder containing the application you choose.

• Choose the application and click the Choose or Open buttons. If you click Cancel, 
the installation will be stopped, and you will need to quit the installer and relaunch it 
if you want to install again. After you choose the application, the plug-ins and sup-
porting files will be installed.
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Authorize Pluggo
When you install pluggo, it’s in demo mode. You’ll see the following dialog box when you 
open the first pluggo plug-in within your sequencer (you’ll see a character string instead 
of the black boxes):

In demo mode, the audio output of each plug-in is interrupted for a moment every 
minute or so.

In order to gain unlimited use of pluggo, you need to run the Authorize Pluggo applica-
tion and enter a valid authorization code.

If you purchased the packaged version of pluggo, your serial number, authorization code 
and Registration ID are inside the pluggo box. If you purchased a pluggo upgrade pack-
age, your information can be can be found on a sticker inside the manual cover. Skip to 
the Entering Your Code section below.

If you downloaded pluggo, you can purchase an authorization code from Cycling ’74. 
The most convenient way to do so is by using a credit card on our secure on-line order 
form. We will send you the authorization code after receiving your order. Here’s the pro-
cedure:

• Run Authorize Pluggo, found in your Pluggo Stuff folder in the root directory of the 
drive where you installed pluggo. The opening screen will ask you whether you want 

Please keep your authorization code, serial number, and Registration ID in a safe 
place.
Authorizing Pluggo 8



                
to purchase a pluggo authorization code, or use an authorization code you have 
received to authorize pluggo, or to get your authorization code again (in the event you 
have lost it). When you select the option to purchase an authorization code and click 
Next, you will see a screen with a Registration ID.

• If you click on the option to purchase an authorization code and click the Web Page 
button or press the return key, the Authorize Pluggo program will start up your web 
browser and automatically take you to the online pluggo purchase form. The program 
will also automatically enter your Registration ID on the online purchase form. Enter 
the additional relevant information on the form and click to purchase an authoriza-
tion code.

• Once we process your order, you’ll receive e-mail with an authorization code. Copy 
the authorization code text in the e-mail message to the clipboard so you can paste it 
into the authorization code page.

If you prefer to purchase a packaged version of pluggo, visit your local retailer or use the 
order form on the Cycling ’74 web site to buy one directly from us. No Registration ID is 
needed to purchase the packaged version—the ID is found inside the box, and you’ll 
need to reinstall pluggo from the CD in the packaged version in order to authorize the 
software.

Entering Your Code

• Run Authorize Pluggo. Select the option to enter an authorization code and click 
Next. You will see a dialog box which shows your Registration ID and provides a 
space for entering your authorization code:

If you see an error message instead, you may need to re-enter your authorization 
code, or re-install the software before you can authorize.

• Click Next after entering your authorization code. You should then a dialog box 
which contains your Registration ID, your Customer Number, and your Authoriza-
tion code.The pluggo authorization serves to authorize every host application that 
uses the same system on your computer.

If you run Authorize Pluggo again and your computer is already authorized, you'll see 
the above dialog.
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Inserting Plug-ins Within Your Sequencer
In this chapter, we’ll cover the steps for inserting pluggo-based plug-ins with Cubase, 
Digital Performer, Live, Logic Audio, Max/MSP, Peak, Pro Tools, and Spark.

When we say “inserting” a plug-in, we mean placing it into the audio processing path of a 
mixer. There are two kinds of insertions. In one kind, used in the Channel Mixer in 
Cubase, the plug-in adds its signal to the input as a kind of bus. Cubase refers to these as 
Send Effects.

In another kind of insertion, used in Pro Tools, Logic Audio, Digital Performer, and in 
the Master and Insert Effects of Cubase, the plug-in replaces its input with its output.

After installing pluggo you will find an assortment of plug-ins in your sequencer’s VstPlu-
gIns folder (In Pro Tools, the folder is called Pluggo Plug-Ins). All of these files will 
Inserting Plugins 10



        
appear in a pop-up menu of plug-ins you can insert. For instance, here is the menu for 
Master Effects in Cubase 4.0.

Is Pluggo Asking for a Plug-in?.

One of the plug-ins in the pop-up menu is special, and it’s worth mentioning because the 
first time you run your sequencer (or possibly every time you run it), you may see its ini-
tial dialog box shown below.

Pluggo is the name of a VST plug-in that loads other plug-ins by letting you choose files 
from a standard open file dialog. In that sense it’s a bit like a joker in a deck of cards.

Note: This section does not apply to MAS and RTAS host applications because 
the Pluggo plug-in is not used. MAS and RTAS users may skip to the Inserting 
Plug-ins: Mono or Stereo? below.
11 Inserting Plugins 



                           
The reason you may see this dialog box when your sequencer starts up is that many 
sequencers load all of their VST plug-ins at startup to determine whether they are mono 
or stereo. Most are intelligent and store the information about plug-ins somewhere in a 
file on your hard disk, so after they open them on startup once, they don’t have to do it 
again. But some programs may not store this information consistently, so you may see 
this dialog each time you launch the sequencer. To prevent this from happening, you can 
either hold down the Shift or Caps Lock key while the sequencer is launching, or take the 
Pluggo plug-in out of your VstPlugIns folder.

In any case, the correct choice, as stated in the directions for the dialog box, is to click 
Cancel to make the box go away.

You may also see the Pluggo plug-in’s open file dialog box in other situations:

• You’ve created a startup document for your sequencer (what Cubase calls an Auto-
load Song) that contains the Pluggo plug-in. In this case, it’s up to you whether you 
want to open a plug-in file or not.

• You’re opening a document that contains a plug-in you opened with the Pluggo plug-
in, but the plug-in can’t be found. There are several reasons why this might be the 
case.

• The plug-in file may have been moved or deleted. pluggo can often find plug-ins if 
you’ve moved or renamed them, but not always.

• There may be a problem with the Pluggo Dictionary file in the Preferences Folder in 
the System Folder. This file stores the locations of all the files opened by the Pluggo 
plug-in. It could be missing, incomplete, or damaged. Or, you may have created the 
sequencer document on one computer and opened it on another, where the Pluggo 
Dictionary file contains conflicting information about file locations.

In any of these cases, you may need to locate the plug-in again. If you used several plug-
in files you originally opened with the Pluggo plug-in, this might be a little confusing, 
since you don’t have any idea which request corresponds to which plug-in. However, 
after you go through the process once, the Pluggo Dictionary file will be updated, so your 
document should read in without any problems from then on.

Inserting Plug-ins—Mono, Stereo, or Multi-Channel

pluggo-based plug-ins can be opened in either a mono, stereo, or multi-channel context. 
However, a mono plug-in may not do what you want if you try to process a stereo sig-
nal—you may just hear processing on the left channel.

It’s also possible in some sequencers to insert plug-ins into a context where they accept a 
mono input signal and produce a stereo or multi-channel output signal.

You can refer to the chart in the Pluggo Plug-in Reference Guide that lists information for 
each of the included plug-ins about whether it can be used effectively in mono, stereo, or 
multi-channel situations (or all three).

Typically, to insert a stereo plug-in, the channel in the mixer you’re using for the plug-in 
has to be a stereo channel.
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To Make a Stereo Insertion in Cubase:

• Choose Master Effects from the Audio menu, and choose a plug-in from the pop-up 
menu to the right of the Edit button. Master Effects in Cubase are always stereo.

To Make a Mono Insertion in Cubase:

• Choose VST Send Effects from the Panels menu, and choose the name of a plug-in 
from the pop-up menu to the right of the Edit button.

• Move the gain slider to adjust the amount of input send to the effect.

• Choose VST Channel Mixer from the Panels menu). Pick a channel on which you 
would like to hear the effect and click on the little FX button above the channel fader.

• The effect send and EQ window for Channel 1 appears. You’ll see the name of the 
effect, in this case, Generic Effect, with an on-off button and a Send volume knob. 
Turn up the gain on the Send knob and click on the on-off button to turn on the 

pluggo is not compatible with the use of multi-processing on multiple processor 
hardware. To ensure that Cubase doesn't crash when using pluggo on a multiple-
processor machine, turn off Enable Multi-Processing and Advanced Multi-Pro-
cessing in the Audio System Setup dialog. Choose Audio Setup -> System... from 
the Options menu to see this dialog.
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effect send. If the blue Pre button is lit, the effects send occurs before the channel 
fader, otherwise the channel fader will attenuate the effects send level.

You can also make an Insert Effect in Cubase that goes between the input (the audio 
track being played) and the rest of the channel’s mixer settings. Unlike the bus effects just 
described, the Insert effect replaces its input. This is the nature of all effects in the other 
applications we’ll cover in this chapter. You might think that an Insert Effect before a ste-
reo pair of channels in Cubase will allow you to use a stereo plug-in, but in fact, you’ll 
only hear the left channel of the plug-in’s output.

To Make an Insertion in Digital Performer: 

• Digital Performer lets you insert plug-ins in its Mixing Board window. In Digital Per-
former, any audio track can have a mono or stereo output. If you want to add an 
audio track with a stereo input to the Mixing Board, you will need to create a stereo 
audio channel.

To create a stereo audio channel in Digital Performer, the Sequence window must be 
active. Click on the Sequence window so that the title bar menus are visible. Choose 
Stereo Voice from the Add Audio Track submenu of the Sequence window’s title bar 
menu. Although the new track will be added, you may need to add a Mixing Board 
track strip for it. Make the Mixing Board window active. On the left side of the mix-
ing panel, you will see a track list. The new stereo voice you added will be grayed out. 
Click on the grayed out track icon, and a new track strip for your stereo voice will 
appear in the Mixing Board window.

If you are using a pluggo-based plug-in that ignores its audio input such as a syn-
thesizer or sampler, you don’t need to turn up the effect sends. The plug-in will be 
able to produce audio as long as its power button is on.

pluggo is not compatible with the use of multi-processing on multiple processor 
hardware. To ensure that Digital Performer doesn't crash when using pluggo on a 
multiple-processor machine, make sure Audio System -> Use Multiple Proces-
sors is unchecked in the Basics menu.
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• Click on the arrow buttons for the effect inserts in an audio mixer channel. A pop-up 
menu listing the available plug-ins will appear.

• If you are inserting an effect on a mono audio channel, all the plug-ins will be shown 
twice in the pop-up menu that appears. The plug-in’s name will be followed by its 
output type (either mono or mono to stereo) in parentheses. If you choose a mono to 
stereo effect, Digital Performer will automatically change the audio output to stereo 
(if you remove the effect, the track will revert to mono).

If you are inserting an effect on a stereo audio channel, you will only be shown the 
stereo to stereo plug-ins.

• Choose the desired plug-in and version (either mono or stereo, if applicable). After 
the plug-in loads, its name will appear in the window for the insert slot you have cho-
sen.

The plug-in’s edit window will also appear.
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 To Make an Insertion in Live: 

Click on the plug icon in the Effects Browser area to see a listing of all the plug-ins in your 
folder. You can also create subfolders to organize your plug-ins.

 • To select a plug-in to load, click on its name. A box will appear around the plug-in 
name to show you have selected it. To add a plug-in to a Live track, click and drag the 
plug-in you have selected to the Track area in the Mix view.

A plug-in panel for the plug-in you have loaded appears in the Track Window.

To Make an Insertion in Logic Audio: 

pluggo is not compatible with the use of multi-processing on multiple processor 
hardware. To ensure that Logic doesn't crash when using pluggo on a multiple-
processor machine, make sure that Multi Processor Support is not enabled for the 
particular hardware driver you are using. You can check the settings for the cur-
rent hardware driver by choosing Audio Hardware & Drivers... from the Audio 
menu.
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• In Logic Audio, any mixer or bus channel can have a stereo output. You don’t need to 
do anything special to set this up. However, only certain channels will have a stereo 
input. These are mixer channels associated with Audio objects that have stereo audio 
files playing back on them. Bus mixer channels always have mono inputs. There is no 
way to tell which channels will have a stereo input and which will have a mono input 
except by context (and listening of course).

There are two ways to use plug-ins in Logic Audio. They can either be inserted 
directly into a mixer channel, or they can be inserted into a bus channel that gets its 
input from a mixer channel’s send. Inserting plug-ins on a bus channel allows you to 
have multiple mixer channels going to the same plug-in(s), as well as making it possi-
ble to control the wet and dry levels separately in cases where a plug-in does not give 
you that option.

• For an insert effect, click once on one of the two boxes below Inserts in a mixer chan-
nel.

• All stereo plug-ins will be shown twice in the pop-up that appears. The plug-in’s 
name followed by (m/s) indicates it will be given a mono input and a stereo output.

• The plug-in’s name followed by (s/s) indicates it will be given a stereo input and a ste-
reo output.

• Choose the desired plug-in and input version. After being loaded, its name will 
appear in green in one of the Insert slots.

• For a bus effect, simply insert a plug-in on a bus channel as you would on a mixer 
channel. If you can’t find the bus channels you should make sure that your audio 
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objects are correctly setup in your Environment – see the Logic Audio manual for 
details. Return to the mixer channel and click and hold on one of the boxes under 
Sends. Select the one of the 8 busses in which you’ve inserted an effect. When the bus 
is selected a knob will appear to its right indicating how much of that channel’s level 
will be sent to the bus. Make sure the bus is assigned to currently active outputs or 
you won’t hear any effect.

To Make an Insertion in Max/MSP:

pluggo 3 plug-ins can be inserted into Cycling '74's Max/MSP environment. The MSP 
vst~ object loads pluggo plug-ins in the same way as any other VST plug-in. Plug-in 
parameters can be changed in Max/MSP via messages to the vst~ object, and the output 
of the vst~ object can be further routed and processed.

The following simple Max/MSP patches demonstrate how to load and use pluggo plug-
ins in Max/MSP. For more information, see the vst~ object manual page in the MSP 
manual.

The following simple patch plays an audio file (myfile) through the vst~ object, which 
will host the Generic Effect plug-in.

Sending the plug message to the vst~ object opens a dialog box that lets you select a plug-
in from the VSTPlugIns folder located in the same folder as the Max/MSP application. 

When the plug-in has loaded, you will see a message listing the number of parameters 
the plug-in has in the Max window.

Sending the message plug, followed by a plug-in name, to the vst~ object, will load the 
specified plug-in. Note that if a plug-in name contains spaces, you will need to enclose 
the name in single smart quotes. 

You can also create the vst~ object with an argument that specifies the plug-in you want 
to load. 

To Make an Insertion in Peak: 

Peak allows you to chain up to five VST plug-ins in series to process audio files. You can 
use pluggo with Peak to process individual audio files, record audio files through a set of 
plug-ins, and to batch process audio files.

For best performance with VST plug-ins, use the ASIO output driver.
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• To insert a pluggo plug-in, select a VST plug-in under Peak’s VST Plug-Ins menu.

The plug-in edit window will appear.

• You can also use Peak’s Vbox with pluggo —either as a standalone program, or using 
the Vbox VST plug-in to host pluggo plug-ins. Vbox has a routing matrix window that 
lets you add up to five parallel sets of plug-ins. Each set can contain five plug-ins. 
Vbox effects are always stereo.

• To insert a plug-in, click on a slot in the routing matrix and choose a plug-in from the 
pop-up plug-in menu.

The Vbox plug-in icon will appear.

• You can add additional plug-ins in series. 
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• You can add additional plug-ins in parallel.

• All plug-ins which are in the same row are connected in parallel with other rows of 
plug-ins. You can reroute this parallel connection by clicking on the routing arrow 
icon located at the input of the plug-in. When you click on the arrow, the connections 
will be rerouted so that you have a single plug-in series with a parallel set of plug-ins 
in the row to the right, as shown (Note: There can only be a single signal path out of 
the right side of the Vbox matrix)

To Make an Insertion in Pro Tools: 

Pro Tools lets you insert plug-ins in its Mixing Board window. In Pro Tools, any audio 
track can have a mono or stereo output, and you can also insert dual mono plug-ins—a 
kind of stereo plug-in which uses two mono output plug-ins, each of which processes 
one channel of the output. If you want to add an audio track with a stereo input to the 
Mixing Board, you will need to create a stereo audio channel.

To create a stereo audio channel in Pro Tools, the Sequence window must be active. Click 
on the Sequence window so that the title bar menus are visible. Choose Stereo Voice from 
the Add Audio Track submenu of the Sequence window’s title bar menu. Although the 
new track will be added, you may need to add a Mixing Board track strip for it. Make the 
Mixing Board window active. On the left side of the mixing panel, you will see a track 
list. The new stereo voice you added will be grayed out. Click on the grayed out track 
icon, and a new track strip for your stereo voice will appear in the Mixing Board window.
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• Click on one of the buttons for the effect inserts in an audio mixer channel. A pop-up 
menu listing the available plug-ins will appear.

If the audio channel is mono, you can insert mono or stereo plug-ins from the plug-
in menu. If the channel is stereo, you can insert stereo plug-ins from the multi-chan-
nel plug-in menu. You can also insert a pair of mono plug-ins on a stereo channel 
using the multi-mono plug-in menu. Usually you will want to use mono or stereo 
plug-ins. Use multi-mono plug-ins if you need to process both sides of a stereo chan-
nel with a mono plug-in. Refer to Digidesign's Pro Tools Reference Guide for more 
information about using these different plug-in channel choices.

 If you are inserting a multi-channel effect on a mono audio channel, all the plug-ins 
will be shown twice in the pop-up menu that appears. The plug-in’s name will be fol-
lowed by its output type (either mono or mono to stereo) in parentheses. If you 
choose a mono to stereo effect, Pro Tools will automatically change the audio output 
to stereo (if you remove the effect, the track will revert to mono).
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If you are inserting an effect on a stereo audio channel, you will only be shown the 
stereo to stereo plug-ins.

After the plug-in loads, its name will appear in the window for the insert slot you have 
chosen.

The plug-in’s edit window will also appear.

To Make an Insertion in Spark:

• Choose Show Master from the Windows menu. You will see the routing matrix win-
dow that lets you add up to four parallel sets of plug-ins. Each set can contain five 
plug-ins. Effects in Spark are always stereo.

• Select a slot in the routing matrix by clicking on one of the gray frames to highlight it. 
Click on the Add Plug-In button and choose a plug-in from the pop-up plug-in 
menu.

The edit window for the plug-in will appear. You can hear your audio file processed 
through your plug-in by pressing the space bar or the play button on the Peak tool-
bar.
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• You can add additional plug-ins in series  route audio between plug-ins using the 
matrix. A plug-in’s outputs will be routed to all the plug-ins in the column to its right. 

All plug-ins that are in a column to the right of another plug-in and are in the same 
row or lower will be connected together.

To remove a plug-in, click on the plug-in you want to remove to highlight it, then 
click on the Remove button.
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Using Virtual Instruments
The VST 2.0 plug-in format supports plug-ins that receive MIDI and generate only audio 
output. In Cubase, these plug-ins are called VST instruments. In Logic Audio, they are 
choices from a set of available Audio Instruments. In Digital Performer and Pro Tools, 
virtual instruments appear on the plug-in menus along with audio plug-ins. Plug-ins of 
this type are not effects processors but synthesizers, samplers or drum machines.

Earlier releases of pluggo included plug-ins that generated audio output such as Synth, 
but pluggo now allows plug-ins to receive MIDI and generate audio information, just like 
a “real” synthesizer. Pluggo 3 includes over 20 virtual instrument plug-ins, and the M2M 
plug-in, which lets you control pluggo plug-ins using MIDI input.

To Use a Virtual Instrument in Cubase:

• Choose VST Instruments from the Panels menu. You will see the VST Instruments 
Panel appear.

• Click on No VST Instr. Choose the big ben bell VST Instrument plug-in from the 
pop-up menu.

To Route a MIDI Track to the Virtual Instrument in Cubase:

• If you have an existing MIDI track in your sequence, you can assign it to “play” big 
ben bell. Click on the Output column for the desired track in the Arrange window 
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and choose Setup Instruments… from the pop-up menu. You will see the Setup 
Instruments Panel appear.

MIDI output from the MIDI track will now be routed to the VST instrument you have 
selected.

• Click on Output menu and choose the big ben bell VST Instrument plug-in from the 
pop-up menu, then click OK. MIDI output from the MIDI track will now be routed 
to the VST instrument you have selected. You can also choose a name for your instru-
ment by typing into the Name window.

To Use a Virtual Instrument in Digital Performer:

In order to send MIDI to MAS plug-ins, you must use FreeMIDI and have FreeMIDI's 
Inter-application MIDI feature enabled.

In order to use virtual instruments with Digital Performer, you must configure Digital 
Performer to allow IAC bus connections if you have not already done so.

• To verify that Inter-application MIDI is enabled, launch the FreeMIDI Setup applica-
tion. Choose FreeMIDI Preferences... from the File menu to bring up the Preferences 
25 Using VST Instruments 



dialog box. Make sure that “Use OMS when available” is not checked, and select 
“Inter-Applications MIDI” as shown..

• Insert big ben bell or another virtual instrument plug-in into an unused channel on 
your mixing board by using the same effects pop-up menu you use to choose other 
plug-ins. You should use an empty audio track because the virtual instrument plug-
in will mute any audio going into the mixing board channel where it is inserted.

You can’t send MIDI to plug-ins if you are using OMS within FreeMIDI.
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To Route a MIDI Track to the Virtual Instrument in Digital Performer:

• In Digital Performer’s sequence window, click on the output menu for the MIDI track 
you want to assign to your virtual instrument.

• You will see a menu item containing the name of the virtual instrument (in this case, 
big ben bell) that points to a submenu. Choose a MIDI channel from this submenu.

• When you start playback you’ll hear the MIDI tracks you selected being played by big 
ben bell.

If you replace one instrument plug-in with another, the MIDI connection for the 
replaced plug-in will not carry over to the new plug-in until you click the Output 
assignment menu (shown above) in Digital Performer's sequence window.
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To Use a Virtual Instrument in Logic Audio:

• In the Arrange window, there should be at least two tracks assigned to Audio Instru-
ments. One is shown selected in the picture below.

• If not, click the title of any MIDI or audio track and choose an Audio Instrument (1 – 
8) from the menu.

• Double-click the Audio Instrument track. You’ll be taken to the corresponding Audio 
Instrument object (channel strip) in the Environment (audio mixer) window.

• A blank rectangle appears at the top of the channel strip to set the source for the 
Instrument. Click on it and you’ll get a pop-up menu with a lot of grayed-out items. 
Near the end of the list you’ll see ES1, the Emagic synthesizer plug-in, plus any virtual 
instrument plug-ins, such as big ben bell.
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• Choose the desired plug-in. Its name appears at the top of the channel strip. 

• You can now return to the arrange window and either record or draw notes into any 
tracks that use the Audio Instrument you’ve configured with the plug-in. The notes in 
the red (selected) track shown below will “play” big ben bell.

To Use a Virtual Instrument in Max/MSP:

You can insert and use pluggo 3 virtual instrument plug-ins in Cycling '74's Max/MSP 
environment in the same way that you use audio plug-ins. The MSP vst~ object loads 
pluggo virtual instrument plug-ins in the same way as any other VST plug-in, and virtual 
instrument parameters can be changed in Max/MSP via messages to the vst~ object. 
(For more general information about loading plug-ins in Max/MSP and accessing their 
parameters, see the section on inserting plug-ins in Max/MSP in the previous chapter of 
this manual.) 

The midievent message to the vst~ object is used to send MIDI information to a virtual 
instrument, as shown in the following simple Max/MSP patch.

For more information about the midievent message, see the vst~ object manual page in the 
MSP manual. 
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To Use a Virtual Instrument in Pro Tools:

• Insert big ben bell or another virtual instrument plug-in into an unused audio chan-
nel on your mixing board by using the same effects pop-up menu you use to choose 
other plug-ins. You should use an empty audio track because the virtual instrument 
plug-in will mute any audio going into the mixing board channel where it is inserted.

To Route a MIDI Track to the Virtual Instrument in Pro Tools:

• In the Pro Tools Mix window, click on the output menu for the MIDI track you want 
to assign to your virtual instrument.

• You will see a menu item containing the name of the instrument (in this case, big ben 
bell) that points to a submenu. Choose big ben bell from this menu.

• When you start playback you’ll hear the MIDI tracks you selected being played by big 
ben bell.
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Using the Plug-in Interface
In this chapter, we’ll be using a mono plug-in called Generic Effect to illustrate the fea-
tures common to all, or at least most, pluggo-based plug-ins.

• Following the appropriate directions for your sequencer for inserting a mono plug-
in, Choose Generic Effect from the pop-up menu of plug-ins.

All the plug-ins included with pluggo have their own edit windows; in other words, they 
don’t use the host sequencer’s interface for changing parameters.

Using the Plug-in Interface in Cubase:

In Cubase, a plug-in with its own interface will show a pop-up menu that lets you change 
effect programs (collections of plug-in parameter settings). You can also change pro-
grams from within a plug-in’s edit window.
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• To see the plug-in’s edit window, click the Edit button. Here’s the Generic Effect plug-
in edit window in Cubase. You’ll see an egg slider corresponding to each parameter of 
the effect and a pop-up menu that lets you change effect programs.
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Using the Plug-in Interface in Digital Performer:

When you insert a plug-in in Digital Performer, its edit window appears automatically.

If you want to see a plug-in’s edit window when it’s not visible, choose its position from 
the Insert menu above the plug-in editing interface. For example, if the plug-in is third 
from the top, choose Insert C.
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In Digital Performer 2.6 and later versions, you can access the preset effect programs 
(MOTU calls them settings) using the menu in the title bar of the Effects window. 

However, settings work very differently in Pluggo running under MAS than they do 
under VST. Here is a summary of the differences:

• If you switch to another preset, Digital Performer does not warn you that you are 
about to lose any changes you may have made to the current preset. This is probably 
not so terrible; we’d guess the warning dialog would become irritating rather quickly. 
However, if you’re used to the VST way of doing things, in which changes to any effect 
program are stored in the effect program when you switch to another program, you 
could lose some work.

To save your work, you have two choices. You can either write over an existing setting 
(probably not a great idea), or you can name a new setting that will be added to the menu 
at the top of the plug-in window. To save a new effect program, choose Save Settings… 
from the plug-in window’s menu, name the settings, and click OK.

VST host applications limit the number of available effect programs to the number spec-
ified by the plug-in itself. With MAS, the number of settings is essentially unlimited.

In MAS, plug-ins do not have “program locations” based on the notion of a program 
change sent via MIDI to change a synthesizer to a stored state. A MAS plug-in’s “settings” 
are collections of individual parameter values copied to a plug-in when the user chooses 
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a new preset from the menu at the top of the plug-in window. In MAS, Pluggo never 
knows when a Digital Performer user chooses a new “setting” or what the “current” set-
ting is. This means that as far as the VST world is concerned, MAS-hosted plug-ins stay 
on the first program. New data from settings chosen by the user is simply copied into the 
first program location in the same way as would happen when you choose Copy All from 
Program from the Parameter Change pop-up menu.

Reading VST Effect Documents into MAS Presets

If you are using Digital Performer 2.6 or later, you can import Cubase format effects files 
for pluggo or other VST plug-ins. Here’s how to do it:

• Create a folder inside the Digital Performer application folder called Pluggo VST Pre-
sets. 

• Put any preset files you have saved in Cubase for any VST plug-ins into this folder. 

• When you insert a VST plug-in that has effect files in the Pluggo VST Presets folder, 
the settings contained in the files will be added to the menu of presets for that plug-
in.

pluggo only looks for new VST effect files when launching Digital Performer or 
restarting the MOTU Audio System. To restart MAS, choose MIDI Only from the 
Audio System submenu of the Basics menu in Digital Performer, then choose 
MOTU Audio System from the same submenu.

pluggo does not come with Cubase format effects files. All of its presets are stored 
within the plug-ins themselves. However, these effects files may be available for 
third-party VST plug-ins.

You can only save VST format effects files in programs that host VST-format plug-
ins such as Cubase or Logic Audio.
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Using the Plug-in Interface in Live:

When you insert a plug-in in Live, an effects panel appears in the Track area.

Clicking on the Edit button will open the default pluggo interface.

You can also display all of the plug-in parameters by clicking on the expand button on 
the effects panel.
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Use the pop-up menu at the top of the effects panel to select a pluggo plug-in preset.

The effect panel in Live includes a x-y controller that lets you control any two plug-in 
parameters you choose by clicking and dragging the circle in the control surface area.

Use the two pop-up menus at the bottom of the effects panel to select a parameter you 
want to control.
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 After you have selected your parameters, start Live and click and drag the circle in the 
control area. You should hear the two parameters change as you drag the circle.

Using the Plug-in Interface in Logic Audio:

To open the plug-in’s edit window in Logic Audio, double-click on the name of the plug-
in.

Logic Audio adds plug-in controls beneath the plug-in’s edit window. If the plug-in win-
dow is too narrow, these controls are sometimes cut off. Click on the program select but-
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ton and choose a pluggo effect program from the pop-up menu that appears (when you 
first load a plug-in, the button reads “PROG 01”).

Logic Audio allows you to use its generic interface for viewing plug-in parameters, which 
gives you a more compressed display than the one in pluggo. To see this display, choose 
Controls from the pop-up menu that displays Editor below the plug-in’s edit window. To 
switch back to the normal pluggo interface view, choose Editor from this menu, which in 
the Controls display mode moves to the top of the plug-in’s window.

Using the Plug-in Interface in Max/MSP:

To open the plug-in’s edit window in Max/MSP, double-click on the vst~ object.
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You can use the View menu to listen to the presets included with each pluggo-based plug-
in. Click on the View menu and choose an effect program from the pop-up menu that 
appears. 

The following simple Max/MSP patches demonstrate how to load and use pluggo plug-
ins in Max/MSP. For more information, see the vst~ object manual page in the MSP 
manual.

To see a listing of plug-in parameters, send the params message to the vst~ object. A list of 
plug-in parameters will be sent out the third outlet of the vst~ object. In this example, we 
are using a print object to show them in the Max window. You can process the output as 
you would any list in Max/MSP.
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You also set plug-in parameters by sending messages to the vst~ object. Control mes-
sages can use the parameter name followed by a value between 0.0 and 1.0 as shown in 
the example patch, or you can send a integer which corresponds to the number of the 
parameter you want to modify, followed by the value for the parameter.

For more information, see the vst~ object manual page in the MSP manual.
41 Using the Plug-in Interface 



Using the Plug-in Interface in Peak:

When you insert a plug-in in Peak, its edit window appears automatically.

The front panel contains a pair of buttons marked with up and down arrows that let you 
step through presets for a plug-in. 

You can use the L (Load) and S (Save) buttons to save any changes to a pluggo plug-in 
preset that you make. 

The B (bypass) button lets you listen to your audio file without hearing the plug-in. 
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Applying Plug-ins to an Audio File in Peak

When you have chosen the pluggo plug-ins you want to use and things sound just the way 
you like them, Peak lets you process your audio file through the plug-ins. This process is 
called “bouncing.” Performing a bounce writes a new audio file to disk, which contains 
the original audio file processed using pluggo.

• To bounce your pluggo effects, select Bounce VST Effects under the VST submenu of 
the Peak Plug-ins menu.

Your audio file will be processed using the plug-ins you’ve selected. The amount of 
time needed to process your audio file will vary, depending on the number of plug-
ins and the size of your sound file.

• Use the Save or Save As… command to save your processed audio file.

Recording Through Plug-ins with Peak 

You can record an audio file through one or more pluggo plug-ins. 

If you don’t want to process any other sound files using the plug-ins you’ve cho-
sen, remove the plug-ins by choosing None from the VST menu. If you don’t do 
this, it will sound like you’re processing the sound file through the same pluggo 
plug-in twice.
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• Once you’ve set up your plug-ins, open a new audio file. Choose the Record Settings 
from the Audio menu. You will see the record settings dialog box appear. Choose 
Record Through VST Plug-ins (and any other settings you want) and click OK.

Batch Processing with VST Plug-ins in Peak

You can perform batch file processing through one or more plug-ins using the following 
procedure.

• After configuring your plug-ins, choose Batch File Processor from the File menu. The 
dialog box shown on the next page will appear.
Using the Plug-in Interface 44



• Click the Add button to add Bounce VST Effects to the list of Selected Processes for 
Batch.

• Enable batch file processing by clicking the On radio button at the top of the dialog 
box. Then click OK.

You can now drop audio files or folders onto the Peak icon in the Finder; the files will be 
batch-processed and the results will be saved in the folder you specified.
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Using the Plug-in Interface in Pro Tools:

When you insert a plug-in in Pro Tools, its edit window appears automatically.

If you want to see a plug-in’s edit window when it’s not visible, choose its position and 
name from the Insert menu above the plug-in editing interface. For example, if the plug-
in is second from the top, choose Insert B.
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Using Built-in Presets in Pro Tools

You can use the View menu to listen to the presets included with each pluggo-based plug-
in. Click on the View menu and choose an effect program from the pop-up menu that 
appears. 

However, settings work very differently in pluggo running under RTAS than they do 
under VST. Here is a summary of the differences:

• If you switch to another preset, Pro Tools does not warn you that you are about to lose 
any changes you may have made to the current preset. This is probably not so terrible; 
we’d guess the warning dialog would become irritating rather quickly. However, if 
you’re used to the VST way of doing things, in which changes to any effect program 
are stored in the effect program when you switch to another program, you could lose 
some work.
47 Using the Plug-in Interface 



To save your settings, choose Save Settings As... from the settings name menu above the 
plug-in edit window. Name the settings in the dialog box that appears and click OK.

Once you have created a setting for a plug-in, you can use it on any plug-in of the same 
type on any channel by selecting it from the setting menu.

In RTAS, plug-ins do not have “program locations” based on the notion of a program 
change sent via MIDI to change a synthesizer to a stored state. An RTAS plug-in’s “set-
tings” are collections of individual parameter values copied to a plug-in when the user 
chooses a new preset from the menu at the top of the plug-in window. In RTAS, pluggo 
never knows when a Pro Tools user chooses a new “setting” or what the “current” setting 
is. New data from settings chosen by the user is simply copied into the first program 
location in the same way as would happen when you choose Copy All from Program 
from the Parameter Change pop-up menu.

Using Dual-Mono Effects in Pro Tools

If you are inserting a dual-mono effect on a channel, you will notice that the plug-in’s 
edit window contains a new channel button and a link button.
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Click on the channel button and use the pop-up menu to choose which of the two 
mono plug-ins will be the “master” plug-in. Choosing one channel will automatically 
set all parameters of the other channel’s plug-in to match the master plug-in.

Click on the Link button to unlink the two mono channels and click OK in the dialog 
box that appears. The Link button will not be highlighted. You can use the unlinked 
mode for some interesting plug-in effects.

Using AudioSuite plug-ins in Pro Tools

In addition to RTAS plug-ins, Pro Tools hosts AudioSuite plug-ins. AudioSuite plug-ins 
process regions of audio already present in your Pro Tools project, rather than processing 
in real time as you record or play back audio. You can read about using AudioSuite plug-
ins in general in Digidesign’s DigiRack Plug-Ins Guide

Some pluggo plug-ins are not useful in the non-real-time AudioSuite context. Examples 
of such plug-ins include any of the software synthesizers, because AudioSuite plug-ins 
cannot receive MIDI events; and any of the modulator plug-ins, because they do not 
affect audio directly. Plug-ins which are not useful as non-real-time plug-ins are not 
added to Pro Tools' AudioSuite menu. 

pluggo uses a special text file to determine which plug-ins appear on the AudioSuite 
menu. The name of the file is Pluggo AudioSuite Plug-ins; it is installed in the Pluggo 
Plug-ins folder in your Pro Tools application folder. If a pluggo plug-in’s name is present 
in this file, it will be added to the AudioSuite menu. We have chosen what we think are 
the plug-ins that are useful as non-real-time plug-ins and added their names to this file, 
but you can modify this file yourself. Maybe you don’t want as many (or any) Pluggo 
plug-ins on the menu, or maybe you think there are other plug-ins that should be on this 
menu. 

You can edit this file with any text editor, adding or deleting the names of plug-in files as 
you choose. The names of the plug-ins must be exactly as they appear in the Finder, and 
must be placed one per line in the file. The next time you run Pro Tools, the AudioSuite 
menu will be updated.
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Using the Plug-in Interface in Spark:

When you insert a plug-in in Spark, its edit window appears automatically. If you want to 
see the window of another plug-in, double-click on the desired plug-in in the routing 
matrix window.

 To access the preset effect programs in Spark, click on the preset button on the plug-in 
edit window and choose a preset from the pop-up menu.

If you double-click on another plug-in, the plug-in view is updated to the new 
plug-in. To open an additional plug-in edit window, hold down the option key 
and double-click.
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You can bypass any plug-in in the routing matrix window by clicking on the Byp button 
in the plug-in’s edit window. The Mute button will mute the audio processing for the 
plug-in and any other plug-ins it is connected to in the routing matrix.

 Applying Plug-ins to a Audio File in Spark

When you have chosen the pluggo plug-ins you want to use and things sound just the way 
you like them, Spark lets you process your original audio file through the plug-ins and 
create a new audio file.

• To process your audio file through the pluggo effects, click on the Create File button in 
the Routing Matrix window. You will be prompted for a name for the new audio file, 
and your effects will be saved to a new file with the name you specify.

Changing Parameters

As you’ve seen above, the initial interface for Generic Effect shows a set of sliders, one for 
each of the effect’s parameters. As you move the mouse over each slider, its knob (or its 
egg if you prefer) is highlighted and information about the parameter appears at the bot-
tom of the window.

Changing parameters is more rewarding when they have an audible effect. Ensure that 
you have an audio signal coming into the plug-in, and that you are hearing the output of 
the plug-in. For Generic Effect, the initial effect preset program is a vibrato. This effect 
should be pretty obvious on most audio signals.

You can change effect parameters by using the sliders or in most cases by clicking directly 
on the displayed value of the parameter itself.
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• To make coarse changes to an effect parameter using the sliders, click on the egg-
shaped knob or anywhere along the length of the slider, then drag to the desired posi-
tion. In coarse mode, there are about 100 different positions available.

• To make fine changes to an effect parameter using the sliders, double-click or option-
click on the egg-shaped knob or anywhere along the length of the slider. When the 
slider is in fine mode, the egg turns red and the cursor disappears, because the slider 
moves much more slowly than your mouse is moving. There are 1024 different values 
possible from the left to right edges of the slider’s range. You can switch between fine 
and coarse modes by pressing and releasing the Option key within a single drag of the 
slider. The cursor will disappear and reappear according to whether you’re in fine or 
coarse mode.

• To make changes to an effect parameter by clicking on its value, move the mouse over 
the value to the right of a slider. The value of the parameter will appear highlighted.

To change the value of the slider, move the mouse pointer over the digit in the value 
you want to change. When you click, this digit will turn yellow, and as you move the 
mouse, you will see the value of the parameter change by increments of this digit. 
Move the mouse up to increase the parameter and down to decrease it.

If a slider is used to select from a small number of possibilities (such as a mono/stereo 
select slider), you will see a pop-up menu appear instead. Use the menu to set the 
parameter’s value. 

When you change a parameter by moving a slider, the value is stored within the current 
effect program (displayed in the edit window of your plug-in). With VST hosts, you don’t 
have to save a program to store your changes as you might on a typical hardware effects 
unit. With Digital Performer and Pro Tools, you do have to save any changes you make, 
and you aren’t warned when you’re about to lose them, for example when switching to 
another preset. 

Changing a parameter by clicking on its value does not work for certain synchro-
nization parameters, nor does it work for third-party VST plug-ins hosted by 
pluggo.
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The Parameter Change Pop-up Menu

Hold down the command key and click on a slider. You’ll get a pop-up menu that looks 
something like this:

The Parameter Change pop-up menu contains commands that deal with parameter val-
ues in the plug-in.

Touch Parameters is used to send out messages to the host sequencer that describe the 
current position of all the controls for a plug-in. It is used with Digital Performer, Pro 
Tools and Logic Audio to aid in plug-in automation. It tells the host that all parameters 
have been “changed” to their current value, so that host can record these changes. This 
command has no effect on the actual values of any plug-in parameters. For an example 
of using this feature, see the Automating Pluggo chapter.

Undo Last Change allows you to go back to the previous setting of a parameter that you 
changed with a slider. It can also return you to the state the plug-in was in before select-
ing a new program.

Choose Undo Last Change again to return to the change before you undid it. (There is 
only one level of undo available.).

Randomize All will set the parameters to random values. This can be useful in finding 
effect settings you never would have been able to come up with if you had adjusted the 
sliders one at a time. Not all parameters may be affected however; the developer of the 
plug-in can keep certain parameters (such as output gain) from being randomized that 
would simply be irritating if they were changed.

Evolve All will nudge each parameter by a random amount up to five percent greater or 
less than its current value.

If you click on a particular slider, you’ll get two additional menu items specific to the 
parameter controlled by the slider. Randomize “Parameter Name” will set the value of 
the parameter whose slider you clicked on to a random value. Evolve “Parameter Name” 

It doesn’t matter what slider you command-click on to activate the pop-up menu 
if you want to choose Undo Last Change. Only the most recent change to any 
slider is undoable, so the slider that was changed last will be reset.
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will nudge the parameter whose slider you clicked on by a random amount up to five 
percent greater or less than its current value.

Copy All from Program lists the names of all of the programs for this plug-in. When you 
choose a program name from this menu, you copy the settings from the selected pro-
gram into the current program. You can Undo this action if desired. 

Using the View Menu

At the top of the pluggo edit window, you’ll see a menu labeled View. When you see the 
rows of egg sliders, the View menu displays the word Parameters. Click on this menu to 
see other pages or views of the plug-in’s interface or to access a plug-in’s presets.

Some plug-ins contain more parameter sliders than will fit in a single page. As an exam-
ple case, if a plug-in has four parameters on its initial screen, the View menu will contain 
an item labeled Parameters 1 - 4. A subsequent page of four parameters would be labeled 
Parameters 5 - 8. The View menu also contains a listing of the plug-in presets.

• Choose Generic Effect Info from the View menu. You’ll see a screen that provides 
information about the plug-in and its developer unless he or she chooses to remain 
anonymous. 

• Choose Pluggo Info from the View menu. This is pluggo’s About Box. Here’s a secret: 
clicking on the pluggo character is the same as Randomize All from the Parameter 
Change pop-up menu. The Pluggo Info view will appear and behave slightly differ-
ently depending on the size of the plug-in.

• Some plug-ins provide a Messages view. This window may provide diagnostic infor-
mation that could be helpful if the plug-in does not appear to be working. For 
instance, you might see a message something like this after opening a plug-in: 

error: plugin~: no such object

Some plug-ins do not display sliders for their parameters as Generic Effect does; 
instead they present an Interface view unique to the plug-in, possibly displaying 
information in a graphical form. Other plug-ins will have both a Parameters view 
and an Interface view. The Interface view may not be called Interface in the View 
menu; the plug-in developer can name it anything he or she wants.
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This particular error indicates an incorrect or corrupted pluggo installation.

Elements of Interface Views

Plug-ins may contain one or more custom Interface views as discussed above. In the 
Interface view, the Parameter Change pop-up menu is also available when you com-
mand click anywhere in the window. Plug-ins with Interface views will contain user 
interface elements from Max and MSP that you may not have seen before. These include:

Note that the contents of the Messages view is common to all pluggo plug-ins. In 
other words, if you’ve already loaded a plug-in that reported information or errors 
in the Messages view, you’ll see the messages it generated in the Messages view of 
any subsequent plug-in you insert.

The Number Box To change a numerical value, click on the 

box and scroll up or down.

The Horizontal or 
Vertical Slider

Using these sliders is self-explanatory, 

except that the cursor disappears while 

moving the knob of the slider. This 

allows fine changes similar to the “fine 

mode” of the egg slider discussed above.

The Vertical Gain 
Slider

This slider is used to make smooth expo-

nential fades to audio signals. The top 

value of the slider is usually +18 dB, 0 dB 

is where the knob of the slider is located 

in the above picture, and the bottom is -

75 dB (essentially the same as a volume 

knob turned all the way down).

The Multislider The multislider is a collection of several 

sliders arranged from left to right. Drag 

the cursor over the entire picture to set 

several slider values. This user interface 

element has a variety of uses. Sometimes 

it will appear as an array of dots or 

squares, as in the waveform draw portion 

of the LFO plug-in.

The Range Slider This slider lets you draw out a range of 

values. Drag from one end of the range to 

the other.

The Toggle Box Click on the box to turn something on or 

off.
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You might also see knobs and buttons of various kinds not described here. If you’re mys-
tified about how they work, the documentation for the specific plug-in effect in which 
they appear should clarify the situation.

Interface Hints and Labels

In addition to the text provided in the Parameters view when you move over a slider, the 
Interface View provides a hint in a small text box about the function of its control ele-
ments. Here’s an example of a hint over a horizontal slider.

If you find the hints bothersome, command-click to get pluggo’s Parameter Change pop-
up menu and choose Disable Hints (a menu item only available in an Interface view). 
This disables hints for all plug-ins. To re-enable hints, command-click to get the pop-up 
menu again, and choose Enable Hints.

The Pop-up Menu Click on the pop-up menu to see a num-

ber of choices

The Breakpoint 
Envelope Editor

You can draw an envelope for various 

purposes with this box. Click on one of 

the existing breakpoints and dragging on 

it will move it to a new location. There is 

a display of the values as you drag the 

breakpoint. Some breakpoint envelope 

editors will allow you to add a new point 

by clicking anywhere on the envelope. 

You may also be able to delete points by 

shift-clicking on them.

The Filter Graph The filter graph lets you draw the fre-

quency response of a filter in several dif-

ferent modes. The solid red circle is used 

to move the center or cutoff frequency. 

The hollow red circle, where applicable, 

determines the width of a bandpass filter. 

Often the filter graph will be accompa-

nied by a set of buttons for choosing filter 

type: lowpass, bandpass, highpass, etc.
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The Level Meter

pluggo contains a handy level meter that tells you whether the plug-in is getting any input 
signal level or producing an output signal. Normally the meter is set to display the level of 
the input signal, as shown below:

• Choose Out to have the meter display the plug-in’s output signal level.

• Choose Off to turn the meter off. Some plug-ins may turn the meter off by default. As 
with any on-screen level meter, the pluggo meter does consume a tiny amount of the 
CPU available for signal processing.
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Plug-in Manager
Plug-in Manager is a standalone application that manages plug-ins for your sequencer 
and many other applications. It works very much like the Mac OS Extensions Manager. If 
you’re not familiar with the Extensions Manager concept, here’s what you need to know.

Plug-ins, like system Extensions, need to be placed in a specific folder in order to be 
used. For VST-compatible sequencers, this folder is called VstPlugIns. For system Exten-
sions, the folder is called the Extensions folder and is found inside your System Folder. 
Take something out of either folder and the next time you restart your computer or 
launch the application, it won’t be used. 

If your sequencer’s plug-ins folder is called VstPlugIns, Plug-in Manager creates a folder 
called VstPlugIns (disabled) inside the folder containing your sequencer and moves 
plug-ins you don’t want to use into this folder. But this file moving operation is transpar-
ent to you if you use the program. All you do to enable and disable a plug-in is click a 
checkbox next to the plug-in’s name.

Plug-in Manager is a free (albeit copyrighted) application. You’re welcome to give it to 
your friends. You just can’t sell it.

MAS host applications have three separate plug-ins folders. The ‘Plug-Ins’ folder 
in the Digital Performer application folder contains Premiere format plug-ins that 
process audio in non real time. The VstPlugIns folder is created by pluggo and 
contains its plug-ins as well as third party VST plug-ins. The Plug-ins folder 
inside the MOTU folder inside the Extensions folder inside the System Folder 
contains MAS plug-ins, including Pluggo for MAS. All of these folders need to be 
managed by Plug-in Manager in separate windows. 

Pro Tools plug-ins live in two separate folders. The PlugIns folder inside the DAE 
Folder inside the System Folder contains AudioSuite, RTAS and TDM format 
plug-ins. The Pluggo Plug-Ins folder inside the Pro Tools application folder con-
tains pluggo plug-ins.
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Starting Plug-in Manager

The first time you launch Plug-in Manager, you’ll be asked to choose a plug-in file inside 
the plug-ins folder you want to manage. Doing so tells Plug-in Manager both the type 
and location of the plug-ins.

Plug-in Manager can manage plug-ins for other applications—graphics pro-
grams, web browsers, etc. This use of the program is not discussed here. But if you 
need a plug-in manager for another application, give it a try.
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When you’ve chosen a Plug-in Folder and plug-in type, Plug-in Manager displays a list of 
all the plug-ins of the chosen type inside the specified folder. An example is shown below.

Unless you’ve created a VstPlugIns (disabled) folder yourself, you’ll find that initially all 
plug-ins will be enabled, so the “On” boxes to the left of their names will all be checked.

After you select this folder, it’s saved in a file called Plug-in Manager Preferences in the 
Preferences Folder in your System Folder. You can choose other plug-in types in other 
folders by choosing New Folder from the File menu. Once a plug-in folder has been 
placed under management, it is listed in the Manage submenu, so you can switch back to 
working with it at any time.

Enabling and Disabling Plug-ins

Before discussing how to disable a plug-in, we should first discuss why you might want to 
disable a plug-in. Here are some possible reasons:

• You aren’t using it and you find its presence in a list of available plug-ins distracting.

• You suspect it’s guilty of destabilizing the host application program.

• You’ve been overusing a plug-in lately and you need to find a fresh artistic approach.

A plug-in is considered On by Plug-in Manager if it is located in the plug-ins folder 
you’re managing, and Off if it is in the plug-ins (disabled) folder. Plug-in Manager dis-
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plays the current state of these two folders. To disable a plug-in, simply uncheck the box 
to the left of its name.

Most applications, including those that use plug-ins, only change the list of plug-ins they 
use when you start up the host application. So you’ll need to quit the host application 
and restart it before the changes will take effect, just as you need to restart your computer 
before changes to extensions take place in the Extensions Manager. A message below the 
list of plug-ins will remind you of this as you enable and disable plug-ins with Plug-in 
Manager.

When Are the Files Moved?

A plug-in file that you enable or disable is not actually moved when you check or 
uncheck the box next to its name. Files are moved from the plug-ins folder to the plug-
ins (disabled) folder (or vice versa) at the following times:

• when you click the Apply button

• when you close a window for a plug-in folder

• when you quit Plug-in Manager

After the files are moved, you can restart the host application and its plug-in list will be 
updated. 

If you’re managing plug-ins for Digital Performer, you can update the plug-in list more 
quickly by choosing MIDI Only from the Audio System submenu of the Basics menu in 
Digital Performer. Then choose MOTU Audio System from the Audio System of the 
Basics menu in Digital Performer. This reinitializes MAS. This technique will apply to 
MAS plug-ins in the Extensions folder as well as Pluggo plug-ins in the VstPlugIns folder.
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Getting Information About a Plug-in

At the bottom of the Plug-in Manager window, a box shows you the date, version (if 
available), and additional information describing the plug-in. Not all plug-ins will have 
any additional information available. 

Saving Plug-in Sets

You can create sets of plug-ins that you want to use together. A set describes which plug-
ins are enabled and which are disabled for a given plug-in folder. Initially, a plug-in folder 
has one set, called My Plug-in Set. To create a new set, choose Create Set from the File 
menu. The Plug-in Manager will ask you to give a name to your plug-in set:

Once you’ve created a set, its name appears on the popup menu at the top of the Plug-in 
Manager window. The current state of each plug-in, enabled or disabled, is stored in 
your new set.

You can create as many sets as you need for a managed plug-in folder. To recall a set, 
choose its name from the popup menu. The enabled/disabled state of each plug-in is 
restored to match the states of the plug-ins as they were when you created the set.

Working with Multiple Plug-in Folders

Plug-in sets can be saved for each plug-in folder you manage. To open a new plug-in 
folder for management, choose its name from the Manage submenu of the File menu (for 
a previously managed folder) or choose New Folder from the File menu (for managing a 
new folder).

Plug-in Manager will open a new window for the folder. The pop-up menu at the top of 
the new window lists all of the plug-in sets that you have created for the Plug-in Folder. If 
you haven’t created any sets yet, only the one called My Plug-in Set will be listed.

Working with Nested Plug-in Folders

Cubase (4.1 and later) and Logic, among other programs, let you organize the plug-ins 
in your VstPlugIns folder by using subfolders. You can create any subfolders you want 
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inside the VstPlugIns folder, and then move VST plug-ins into those folders. They will 
then appear as submenus in any effect selection pop-up menus.

With this feature, you can create subfolders for different types of plug-ins (such as granu-
lar plug-ins, distortion plug-ins, or plug-ins that you’re currently developing) and move 
the plug-ins into those folders. You can then view and select your plug-ins quickly and 
easily, even if you have a large number of plug-ins in the Cubase VstPlugIns folder.

When Plug-in Manager finds subfolders containing plug-ins, it adds the folder’s name to 
the display along with a disclosure triangle. You can click on the disclosure triangle to the 
left of a folder’s icon to view the plug-ins contained in that folder.

You will need to create any subfolders in the VstPlugIns folder that you want to 
use manually using the Finder before you run Plug-In Manager. You cannot use 
Plug-In Manager to create subfolders and cannot move plug-ins from one folder 
to another.
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Plug-ins within a subfolder can be enabled/disabled individually. If a folder contains 
both enabled and disabled plug-ins, its checkbox will show a horizontal line. You can 
enable/disable all of the plug-ins within a subfolder by clicking the subfolder’s checkbox.

Plug-In Manager adds subfolders to the disabled plug-ins folder to match subfolders in 
the corresponding plug-ins folder. If you add, rename, or move subfolders or plug-ins 
within a plug-in folder, Plug-In Manager will accommodate the changes and display the 
subfolders and plug-ins appropriately the next time it runs. However, any plug-in sets 
you created before rearranging the contents of your plug-in folder will probably not be 
useful any longer, since Plug-In Manager will not be able to restore your plug-ins to a 
previous state if they are no longer in the same place as they were when that state was 
saved with a plug-in set.

Do not attempt to move plug-ins or subfolders of the plug-in folder when Plug-In 
Manager is displaying the contents of this folder in one of its windows. It will 
become confused, and you know how dangerous a confused Manager can be.

Also, the preferences files used by Plug-In Manager 1.1 (included with pluggo 2.0 
and later versions) are not compatible with older versions of Plug-In Manager. If 
you have used Plug-In Manager 1.0, all of your preferences files—your saved 
plug-in sets for each application whose plug-ins you manage—will be converted 
to the new format when you run Plug-In Manager 1.1 for the first time. After this 
conversion, earlier versions of Plug-In Manager will not recognize your plug-in 
sets, and should not be used.
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Synchronizing Plug-ins
The synchronization features of pluggo allow the operation of a plug-in to be tied to 
events going on in the outside world. Some, but not all, pluggo plug-ins support one or 
more forms of synchronization. The “slickest” synchronization mode uses the timing 
information from the sequence, and is available in applications that support the VST 2.0 
or MAS plug-in formats. For sequencers without this capability, or for special types of 
synchronization that respond to elements of audio tracks themselves, there’s the Plug-
goSync plug-in, which can “listen” to an audio signal fed to its input and derive sync 
information from it that can be used by other pluggo -based plug-ins. 

In the other synchronization modes, plug-ins use their own timing source that has no 
connection with anything going on outside.

Opening the Sync Example Document

To demonstrate synchronization, we’ve included example documents for Cubase, Logic, 
Digital Performer, and Pro Tools.

• Choose Open... from your sequencer’s file menu.

• Locate and select the Sync Example document appropriate for your sequencer. You’ll 
find it in the Sync Examples folder within the Pluggo Stuff folder.

• In your sequencer’s transport window, click on the Play button, then when you’ve 
heard enough, click Stop.

This document contains samples of spoken numbers processed through the Audio Rate 
Pan plug-in. What we’ll be discussing in the context of this example is various ways we 
can set the rate of left-right panning.

The Audio Rate Pan edit window should appear when you open the document. Note that 
synchronization parameters appear in orange, a convention followed by most pluggo -
based plug-ins.

Exploring the Synchronization Modes

There are four sync modes available in the Audio Rate Pan plug-in: Free, Host, Plug, and 
UDT. You set the sync mode by using the pop-up menu in the Tempo/Sync parameter 
(number 9). Not all plug-ins will organize sync options in exactly the same way, but 
Audio Rate Pan provides all the available options you’ll encounter. We’ll summarize each 
mode briefly here:

• Free mode allows you to determine rate and duration parameters using milliseconds 
or Hertz units. In this mode, the plug-in ignores synchronization information, or to 
put it another way, it is “free running.”

• Host mode locks the rate and duration parameters to the tempo of the sequence 
you’re playing through the plug-in. Typically, no change in these parameters will be 
heard unless the sequence is actually playing. You specify rate and duration parame-
ters in terms of note units, such as whole notes or quarter notes, plus a multiplier. 
65 Synchronizing Plug-ins 



Host mode can be selected in host environments that don’t support direct synchroni-
zation, but it will be the same as specifying a duration of zero.

Plug mode is similar to Host mode except that the PluggoSync plug-in supplies the 
synchronization information instead of the host sequencer. This means that in order 
for Plug mode to work, you’ll need to have a PluggoSync plug-in inserted someplace. 
We’ll discuss how PluggoSync works below. Plug mode is available in all host applica-
tions.

UDT (which stands for User-Defined Tempo) mode is similar to Free mode in that 
no synchronization between the plug-in and the host occurs. It differs from Free 
mode in that you’re allowed to specify rate and duration in terms of note units and a 
multiplier. However, the plug-in uses a tempo you specify rather than obtaining it 
from the host. In other words, UDT is simply an alternate method of specifying time 
that might be more musical for certain users than milliseconds or Hertz.

Host Mode

In the example documents for Cubase, Digital Performer, and Logic, Host mode is ini-
tially selected in the Audio Rate Pan edit window. Users of applications that do not sup-
port this capability can skip this section (or read it with envy).

In Host mode, the modulating oscillator that pans the audio input from left to right is 
synchronized to the beat. The Audio Rate Pan edit window appears as shown below.

Note at the bottom that the Tempo/Sync parameter is set to Host and that you can’t 
change the orange egg slider next to the pop-up menu. In Host mode, the slider acts as 
an indicator of the current tempo of the sequence that is playing. You’ll also note that the 
Fine Pan Freq, Mod Freq, and Mod Depth parameters are grayed out. These are disabled 
in both Host and Plug modes. Instead, the information that controls the audio panning 
rate is derived from your sequencer application and you set the relationship of the pan-
ning frequency to the tempo by using the slider and pop-up menu combination shown 
for the Coarse Pan Freq parameter. In the example, the Coarse Pan Freq is 1.0000 * 1, 
meaning 1.0 times a whole note (i.e., four beats if the time signature is 4/4). 
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• Start playing the example sound file and change the tempo value in the tape transport 
window. You will notice that the value of the Tempo/Sync slider changes when you 
alter the playback tempo of the sequence. You should hear the pan rate change in 
accordance with the tempo as well.

• Click on the pop-up menu in the Coarse Pan Freq parameter. This menu lets you 
specify note units that subdivide the beat at the current tempo.

These options represent abbreviations for various timing values of musical notes. 
Included are whole note (1), half note (1/2), quarter note (1/4) and so on. A note 
value with a period after it represents a dotted note. A note value with a “t” after it rep-
resents a triplet.

• Select the half note value from the pop-up menu. You will now hear the audio rate 
sweep at twice the rate of speed (i.e. four times per second).

So far, the Coarse Pan Freq parameter’s egg slider has been set to a value of one. You 
can use the slider to set a value to multiply the note unit chosen in the pop-up menu. 
For instance, you can use this to set much longer durations of synchronized change.

• Set the Coarse Pan Freq slider to a value of 4.0000, and set the pop-up menu value to 
a whole note, as shown:
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You will now year the audio pan from left to right once every two seconds. You can use 
the slider and the note value pop-up menu to create complex timing relationships. 

Free Mode

Free mode is supported by all host applications.

• Choose Free from the Tempo/Sync parameter pop-up menu.

In Free mode, the plug-in uses its own built-in clock or oscillator to derive rates of mod-
ulation (in this case, the Coarse and Fine Pan Freq sliders). You’ll notice that the Tempo/
Sync egg slider is grayed out. That’s because the modulation rate is not set in terms of a 
relationship to a beat; rather, it is set in terms of absolute time. If you were a user of pluggo 
1.0, you’ll recognize this as the way the Audio Rate Pan plug-in functioned.

UDT Mode

• Choose UDT from the Tempo/Sync parameter’s pop-up menu.

As mentioned before, UDT stands for User-Defined Tempo. This mode allows you to 
specify a tempo, note unit value, and multiplier to determine the rate of panning. 
These values are independent of the tempo of the host sequence.
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The Fine Pan Freq, Mod Freq, and Mod Depth parameters are available in UDT mode.

• Click on the displayed value of the Tempo/Sync parameter and change the tempo to a 
lower value. You should hear the rate of panning slow down accordingly. 

You can also use the Coarse Pan Freq note value pop-up menu and multiplier slider to 
change the panning rate.

Plug Mode

Prior to the release of host applications with synchronization, pluggo used a plug-in 
called PluggoSync to provide a way to synchronize plug-ins with the tempo of your 
music. PluggoSync uses a “click track” that feeds the PluggoSync plug-in, and the plug-in 
then outputs synchronization to other plug-ins. We’ll discuss the PluggoSync plug-in in 
more detail in the next section.

This technique is still applicable to those host applications that do not have synchroniza-
tion features, but it’s also useful in those that do. You can use the PluggoSync plug-in to 
respond to cues other than the timing information supplied by your host application (for 
example, you can use it to insert cues in your song that control your plug-ins indepen-
dent of timing and tempo).

We’ve included a second audio track in the Sync Example document containing a “sync 
sample” audio file that is fed to the audio input of the PluggoSync plug-in. The sync audio 
file has been placed at the beginning of every beat. This is the click track. You’ll also see 
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the first track that contains the audio that’s being panned. Here’s what the song looks like 
in Cubase.

• In the Audio Rate Pan plug-in, choose Plug mode from the Tempo/Sync parameter’s 
pop-up menu.

In the Audio Rate Pan plug-in, Plug mode functions similarly to Host mode. You specify 
the relationship between the panning rate and the tempo derived from PluggoSync using 
the note value pop-up menu and multiplier slider in the Coarse Pan Freq parameter. 

Note that the Fine Pan Freq, Mod Freq, and Mod Depth parameters are grayed out, as in 
Host mode. The information that controls the audio panning rate is derived from Plug-
goSync.
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• Play the sequence. You should hear the Audio Rate Pan plug-in panning the audio 
track in sync with the click track on Audio 1. This click track is sending its audio sig-
nal to the PluggoSync plug-in instead of using the host application.

• Try using your sequencer’s arrangement window to change the spacing of the sync 
track units at odd intervals and listen to what happens.

• Return to the edit window of Audio Rate Pan. While the sequence is playing, try 
changing the Coarse Pan Freq note value pop-up menu and multiplier sliders to 
change the panning rate.

In the next section, we’ll take a closer look at how the PluggoSync plug-in works.

Using PluggoSync

Synchronization using the PluggoSync plug-in requires that you create a “click track” that 
feeds the PluggoSync plug-in. The synchronized plug-ins then “listen” to one of Plug-
goSync’s synchronization sources. 

• Open the edit window of PluggoSync.

PluggoSync has a number of features we aren’t using in our example document. The Plug 
mode of Audio Rate Pan uses the basic beat information generated from PluggoSync 
when it is set to Audio Sync mode. (The other mode, Internal BPM, is discussed below.) 

At the bottom of the PluggoSync edit window, you’ll see a Beat Divider feature that allows 
you to subdivide the basic beat information being generated. For example, a division of 8 
means that 8 “sync pulses” are generated for every beat. Certain plug-ins, such as Synth, 
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can be set to listen to one of the four beat division selections as shown below where it’s 
been set to listen to PluggoSync output 1.

This feature is not used with Audio Rate Pan, which has its own note value and multiplier 
specifications that are somewhat more powerful than the ones inside PluggoSync.

Feeding Audio to PluggoSync

To add synchronization capabilities to an existing song, you need to add a click track that 
feeds the PluggoSync plug-in. You do this in two steps:

• Import the audio file sync.aiff found in the Pluggo Stuff folder onto an audio track, 
and make copies of it so that it plays once every bar of the sequence.

• Next, insert the PluggoSync plug-in and send it the audio from the click track. 

Note that if you don’t want to hear the click track in your mix, you have several options: 

• In Cubase, Logic, Digital Performer, and Pro Tools, you can use PluggoSync as an 
Insert Effect. Since PluggoSync will not echo its audio input to its audio output unless 
you have the Thru toggle checked in its edit window, the click track is silenced.

• In any version of Cubase, you can use a Send Effect and enable the Pre (for pre-fader 
send) button for the effect send. Then turn down the channel fader for the click track. 
The clicking sample is sent only to the plug-in, not the mix.

Check the meter below the words Audio Sync in the PluggoSync edit window to make 
sure PluggoSync is receiving the audio, and you will see it ‘lock up’ to the click track.

The more devious among you may have already noticed that you can use any audio sig-
nal as a click track, but we don’t guarantee the results.
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• To set PluggoSync to run on its own internal clock, ignoring its audio input, click on 
the purple triangular button so it points to Internal BPM. Then you can set a tempo 
with the number box. 

One use of the internal clock is to keep your plug-ins in sync with each other without a 
click track. PluggoSync’s internal clock will simply run freely at the designated BPM and it 
will run whether or not your sequencer is playing a song. In other words, PluggoSync is 
functioning as a sequencer inside your sequencer.
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Using Modulator Plug-ins
pluggo’s Modulators are plug-ins that do not process any audio. Instead they are designed 
to modify the parameters of other plug-ins. pluggo provides a number of different Modu-
lators. We’re going to look at one of the simpler ones called Mouse Mod. It lets you move 
the cursor around the screen (without clicking) to change up to four different parame-
ters at once. Since you can have several Mouse Mod plug-ins operating at the same time, 
even more parameters can be changed if you like this sort of thing. Other Modulator 
plug-ins, such as LFO, generate automatic control signals, allowing modulation effects to 
be accomplished without the danger of repetitive stress injury. LFO can also be synchro-
nized to PluggoSync so the repeating changes can be tied to the metric structure of your 
music.

Modulator plug-ins pass audio signals through them; indeed, most ignore their audio 
inputs completely. So you can insert them anywhere without affecting the signal path of 
your mixer.

• Set a channel in your sequencer’s mixer to handle an audio signal and insert both the 
Mouse Mod and Generic Effect plug-ins on that channel. You can put Mouse Mod 
before or after Generic Effect in the effect chain, it doesn’t matter.

• Open the Mouse Mod edit window.
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• Click on the top menu (corresponding to Horizontal 1) in the Assign column, and 
choose Generic Effect 3 Feedback Gain.

Then choose Set from the Mode menu immediately to its left. This assigns the hori-
zontal position of the mouse to modify Generic Effect’s feedback gain coefficient.

• Click on the menu corresponding to Vertical 1 in the Assign column, and choose 
Generic Effect 2 Feedforward Gain. Then choose Set from the Mode menu immedi-
ately to its left. This assigns the vertical position of the mouse to modify Generic 
Effect’s feedforward gain coefficient.

• Open the Generic Effect plug-in’s edit window. You should see the Feedforward and 
FB Mod Depth parameters moving around as you move the mouse on the screen, 
and you should also hear a change in the audible result. Experiment with different 
Output Ranges in the Mouse Mod window (just click to drag out a range); this will 
affect the ratio of mouse position to parameter change. For these two gain settings, a 
value that’s too high will cause distortion, so it’s best to limit the Output Range to the 
middle of the total range, like this:

Next, we’ll apply Mouse Mod to modulate the settings of a VST plug-in that isn’t included 
with pluggo.
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Using Other VST Plug-ins within Pluggo

pluggo has the ability to open and host VST plug-ins, including those that were not writ-
ten using Max/MSP. This feature works differently depending on whether you are using a 
VST or MAS host environment. Please refer to the section below that is appropriate for 
your environment.

Using Other VST Plug-ins within MAS

If you’re using an MAS host, pluggo makes it extremely easy to use other VST plug-ins 
and Max/MSP patches. Simply drop the plug-ins and patches into the VstPlugIns folder 
contained within your MAS host’s application folder, and restart the application. In Dig-
ital Performer, you’ll see the plug-ins listed in the pop-up menu of effects in the Mixing 
Board window.

One obvious benefit of pluggo for MAS users is that it serves as a way to use VST plug-ins 
within MAS applications. Another benefit is that non-pluggo VST plug-ins can have their 
parameters modulated by pluggo Modulator plug-ins.

In addition, pluggo adds its interface enhancements to the VST plug-ins it hosts, includ-
ing undo, parameter randomization, and display of all plug-in parameters as egg sliders 
with coarse/fine control.

For more information on these features, skip to the section below entitled Features of 
Hosted Plug-ins.

The Pluggo plug-in

The Pluggo plug-in has the ability to open and host other VST plug-ins. You can use it to 
open VST plug-ins made with Max/MSP, which is just like loading them from a menu in 
the host sequencer. You can also use it to open Max/MSP documents directly without 
having to make them into VST plug-ins, a feature typically only useful to plug-in devel-
opers. Most importantly, however, you can use the Pluggo plug-in to open VST plug-ins 
that were not made with Max/MSP.

For various technical reasons and at Digidesign's request, the RTAS version of 
Pluggo does not host third-party VST plug-ins. Pro Tools users can therefore skip 
this chapter.

pluggo cannot host MAS plug-ins, nor can it modulate the parameters of MAS 
plug-ins.

The Pluggo plug-in can only be used in VST host environments. MAS users can 
skip this section.

Sorry, fans of self-reference: the one VST plug-in that cannot be opened by the 
Pluggo plug-in is the Pluggo plug-in itself.
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Why would you want to open a VST plug-in using another plug-in when you can just 
insert it directly within the sequencer? The main benefit is being able to modulate a plug-
in’s parameters using a pluggo Modulator plug-in. Other benefits include the user inter-
face enhancements of pluggo plug-ins, such as undo, parameter randomization, and dis-
play of all plug-in parameters as egg sliders with coarse/fine control. Here’s how you do 
it:

• Insert the Pluggo plug-in, and when the open file dialog appears, choose the appro-
priate plug-in or Max/MSP document. Most of your plug-ins will probably be in 
your sequencer’s VstPlugIns folder. But Pluggo allows you to open a plug-in file that’s 
located anywhere. .

Features of Hosted Plug-ins

If a plug-in has its own edit window, this interface is displayed first when you open its 
pluggo-hosted edit window. If not, you’ll see all of the plug-in’s parameters displayed as 

Some VST plug-ins don’t work correctly if they’re not in the VstPlugIns folder of 
the host application you’re currently using. Some may require auxiliary files to be 
in specific locations such as a specially named subfolder of the VstPlugIns folder.
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sliders. For VST plug-ins with their own edit windows, you can use the pluggo View 
menu to see the parameters. 

Here is Prosoniq’s North Pole filter plug-in being hosted by the Pluggo plug-in.

To access the undo feature for a hosted plug-in, command click on plug-in’s edit window 
to get the Parameter Change pop-up menu and choose Undo Last Change. This menu 
also contains the parameter randomization commands described in the Using the Plug-
in Interface chapter. 

Modulating the Parameters of a Hosted Plug-in

As we mentioned above, the main reason you’ll want to host VST plug-ins with pluggo is 
to modulate their parameters with a Modulator plug-in. Here’s an example where we will 
modulate parameters of a chorus-type plug-in with mouse movement. For Cubase, we’ll 
use the Choirus plug-in. (Logic Audio and Digital Performer don’t ship with any VST 
plug-ins, so if you’re a Logic Audio or Performer user and you have some VST plug-ins, 
feel free to use them instead of the chorus effects discussed here.)

Since VST plug-ins with their own edit windows never had their parameters 
exposed by name before, many do not provide names for their parameters. The 
names you see (P1 - P10 for example) may not be very helpful or even erroneous. 
Contact the publisher of your favorite plug-in and ask them to add parameter 
names. It will be very simple for them to do.
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• If you’re using Digital Performer or another MAS application, move the chorus-type 
VST plug-in to the VstPlugIns folder that’s a subdirectory of the application. You 
must quit and restart your MAS host application to update the effects pop-up menus 
after making any changes to this folder.

• Insert the Mouse Mod plug-in somewhere if it’s not already present.

• If you’re using an MAS host application, simply insert the chorus-type VST plug-ins 
you wish to modulate by choosing its name from the pop-up menu of available 
effects.

• If you’re using a VST host, insert the Pluggo plug-in, and when the open file dialog 
appears, insert the appropriate chorus plug-in, which you should find in your 
sequencer’s VstPlugIns folder.

• Ensure that you have some audio going through the chorus effect.
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• Open the Mouse Mod window, click on the top menu in the Assign column, and 
choose to modulate the Feedback parameter. Then choose Set from the Mode menu 
in the same row.

• For another effect: Open the Mouse Mod window, click on the top menu in the Assign 
column, and choose to modulate a parameter you think will have some audible 
effect.

• Move the mouse so the cursor changes horizontally. You should hear an audible dif-
ference as the modulated parameter changes. If you open the edit window for Choi-
rus, you will see the Feedback slider change when the mouse moves.
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Getting On the PluggoBus

In audio mixer terminology, a bus is a signal path that can be both an input and output 
for different elements of the mixer. For instance, the output bus on a mixer is the sum of 
all the individual channels feeding into it. Other types of busses (yes, that’s the way it’s 
pluralized) combine effects or input channels, but you don’t necessarily listen to them 
directly in a final mix.

pluggo features its own audio bus, which is called, logically enough, the PluggoBus. It’s 
designed so that plug-ins made with Max/MSP can send audio signals directly to each 
other. Why is this necessary when most sequencers today offer flexible “virtual” bus 
architectures? One reason is demonstrated by pluggo’s Vocoder plug-in, which requires 
both a carrier source and modulator in order to function effectively. The source is often a 
synthesizer, while the modulator that filters it is often a vocal track. But it’s also interest-
ing to experiment with other types of sounds as sources, some of which may be gener-
ated by plug-ins, and some of which might come from audio files playing into your 
mixer.

In any typical mixer setup, the inputs to effect plug-ins are tied together as a stereo pair. 
But in this case, we want two inputs that are completely different from one another.

PluggoBus Receivers

Below, we’ve shown a slider in the Vocoder interface that lets you select the Carrier 
Source. 

You can choose PluggoBus 1L through 4R as carrier sources instead of using Vocoder’s 
internal synthesizer. These assign whatever is on the bus as the carrier source for vocod-
ing (the modulator is always the audio signal fed into the input of the Vocoder plug-in).
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In addition to specific plug-ins that accept information from the bus, there is also a plug-
in called PluggoBus Rcv. This plug-in can be used to feed an effect inserted below it with 
the contents of the bus.

The Source Bus L and Source Bus R choose what you want to send to the plug-in’s out-
put. You can also mix a desired level of the plug-in’s input with what’s on the bus with the 
Mix Input sliders.

PluggoBus Senders

Now we’ve seen how to get things off of the bus, let’s show you how you can put things on 
the bus. The PluggoBus Send plug-in takes its audio input signal and assigns it to one or 
two PluggoBus outputs.

 The large yellow sliders set the input level fed to the bus. The input can also be delayed by 
a multiple of the number of samples the sequencer’s mixer processes at one time. This 
allows you to solve synchronization problems that arise when you try to send audio from 
a plug-in that comes later in the mixer’s processing chain to one that comes earlier.
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Other PluggoBus sources will include plug-ins that generate more than two output chan-
nels. For instance, the Dr. Dop plug-in can create a four-channel spatialization of its 
input. You can send its outputs to the plug-in’s outputs of course, but that’s only two 
channels. The other channels (3 and 4) are obvious candidates for the PluggoBus.
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Plug-in Automation
Some sequencers allow you to capture changes you make to pluggo plug-ins while the 
music is playing back, then replay these changes in time with the music. The most com-
mon application of this feature is automated mixdown—meaning you essentially get 
more hands to move mixing board controls while the music plays back. Here we’ll show 
you how to use the automation features of various hosts with pluggo.

Automation in Cubase

You can use the Write function of the VST Channel Mixer to capture changes you make 
to pluggo edit windows—as well as volume, panning, muting and soloing in the VST 
mixer itself—into a special Audio Mix part. You can add additional changes in subse-
quent “passes” to this Audio Mix part, and undo any passes you’re not happy with. When 
you play back the Audio Mix part, all captured fader movements or button pressing will 
be repeated just as you performed them, complete with exciting dancing on-screen fad-
ers.

To Record Your Actions:

• Open the VST Channel Mixer.

• Using the Windows menu, open the effects panel corresponding to the effects you 
want to automate (either Send Effects or Insert Effects). 

• Click on the Edit button corresponding to the plug-in you want to automate.

• Click on the Write button in the upper left corner of the Channel Mixer.

For more information on automation, refer to the manual of your host applica-
tion. Our discussion of the topic here is not intended to replace the host applica-
tion’s documentation of its automation features.
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• Start the music playing. Every change you make on the Channel Mixer or a plug-in 
edit window will be recorded when the Write button is active.

If you check the Arrange window, you will see that clicking on the Write button creates a 
new Mixer Track called Audio Mix.

This track will contain a record of all your actions. Each time you click the Write button 
while playing the sequence back, another pass is added to the Audio Mix part containing 
the new changes.

Since you can create an automated mixdown by layering, you’ll find it easiest to work 
with a single plug-in or a single channel at a time. If you turn off the Write button at the 
end of your mixdown pass, you can undo your most recent pass if you don’t like it by 
choosing Undo from the Edit menu.

• Stop playback.

• Click on the Write button in the Channel Mixer, disabling recording of your actions.

When the Write button is on, you can also stop playback on the transport control. 
Any changes you make to your mixer parameters when stopped are recorded at 
the current Song Position. You can use this to add exciting abrupt changes in your 
mix, pause to bring up new plug-in edit windows, or to set initial settings for your 
plug-ins or Mixer Channels. 
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To Listen to the Actions You’ve Recorded:

• Click on the Read button in the Channel Mixer.

• Start playback. The faders and controls will move automatically, following your 
recorded actions.

If you aren’t happy with what you just recorded, you can undo your pass by choosing 
Undo from the Edit menu. Repeat as necessary.

Automation in Digital Performer

Digital Performer 2.7 and later lets you automate effects parameter changes in two ways. 
You can insert and graphically edit control envelopes for pluggo effects parameters and 
you can record fader changes in real time. The menus you use to enable and set up effects 
automation are available in Digital Performer’s Mixing Board and Audio Tracks windows 
and in the edit window of any effect. In the following examples, we’ll show you how to 
add effects automation from the Audio Tracks Window, and from the front panel of a 
plug-in.

To Add an Effects Control Envelope: 

In this example, we'll add an automated envelope to control the Feedback Gain of the 
pluggo Generic Effect plug-in to a track that we’ve already recorded. We'll assume the 
Generic Effect has already been inserted in audio mixer channel 1, and that we've already 
found a sound we like.

• Open the Tracks window for your sequence by choosing Open> Tracks from the 
Windows menu. 

You can turn on the Write and Read buttons at the same time. You would do this if 
you wanted to listen to the actions you’ve already recorded while you are working 
with a new Channel or plug-in during another record pass.
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Double-click on the track to bring up the Audio Edit window. You’ll see a representa-
tion of the track(s) you’ve inserted or recorded.

• You’ll the see an Auto (for automation) menu button in the Track information area. 
This button shows you the current status of automation on all your tracks, and is also 
a pop-up menu you use to set up and enable or disable effects automation. When the 
automation button is blue, automation playback is enabled. 

• Click on the Auto button and choose Setup... from the pop-up menu to open the 
Automation Setup window.

• Using the pop-up Add menu from the Automation Setup window, choose Add All 
from the Generic Effect submenu. 
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• You will now see the Generic Effect parameters listed in the Automation setup win-
dow. Click on Apply to Selected Audio Tracks button to apply these choices to the 
Audio track you’re working on.

You can keep this menu open to enable more parameters later on, or close it now.

• To create a snapshot of the current parameter settings of your pluggo effect, rewind to 
the beginning of the audio track using the Transport Control. 

Click on the Snapshot icon in the Audio Tracks window to display the Automation 
Snapshot window.

• The Automation Snapshot window lets you choose the time range you want to apply 
your automation envelope to, the tracks you want to create a snapshot of, and the 
types of parameters you want to automate. Choosing All time will create an envelope 
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which begins at the start of the track we're working on (which will be composed of 
straight lines, since there are no parameter changes until we add them). Choosing the 
Tracks: option as shown creates a snapshot of our Generic Effect plug-in only. Choos-
ing the Data Types: option lets you select all the Generic Effect parameters. Click OK 
to create the snapshot.

• You will now see a set of horizontal lines superimposed on Audio Tracks window for 
the audio track. There is one line for each effects parameter for the Generic Effect 
plug-in.

• Click on the button marked “Insert A” and choose the Feedback Gain selection from 
the pop-up menu to select the parameter.
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• The Feedback Gain parameter will be highlighted on the audio track display. You can 
add new breakpoints to your effects envelope by positioning the cursor on the cur-
rent line and clicking.

• You can change the envelope values at a breakpoint by clicking and dragging the 
breakpoint. You will see the position and current value of the breakpoint you are 
changing at the upper left of the Audio Tracks window. Add and adjust new break-
points until you are satisfied with the results.

To Listen to Your Actions:

• Click on the Play button on the Transport Control to hear the amount of Feedback 
Gain change.

To Record Your Actions: 

You can also record pluggo effect parameter changes in real time. In this example, we’ll 
record some changes to the Feedback Gain of the Generic Effect plug-in on a previously 
recorded track. Notice that we can access the same setup and configuration menus we 
used to add an effects envelope from the edit window of any plug-in.

• The Generic Effect editing window also has an Automation button located above the 
effects sliders. Click on the automation button in the Generic Effect edit window and 
choose Setup... from the pop-up menu to open the Automation Setup window.

• As shown in the previous effects control envelope example, use the pop-up Add 
menu from the Automation Setup window to add all Generic Effect parameters, and 
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Click on Apply to Selected Audio Tracks button to apply these choices to the Audio 
track we’re working on.

• To enable effects automation recording, click on the automation button and select 
Record... from the pop-up menu.

• Notice that the automation indicator button in the Audio Tracks window is now red. 
This indicates that recording automation is enabled. 

• To record your parameter changes, Click on the Play button on the Transport Con-
trol. 

Note that you do not need to use the Record button for effects automation. Move the 
Feedback gain slider as the track plays. If you are using Latch Mode, you will record 
each parameter change every time you listen to the track and move the faders (i.e., 
you’re “overdubbing” effects changes). If you are working in Overwrite mode, each 
pass will erase all the effects changes you added before. Play and record your effects 
changes until you’re satisfied.
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• To see the parameter changes you’ve recorded, open the Tracks window for your 
sequence by choosing Open> Tracks from the Windows menu. 

You’ll see a representation of the track(s) you’ve inserted or recorded.

Automation in Logic Audio

Logic Audio Version 3.7 or later lets you automate effects parameter changes in two 
ways. You can record fader changes in real time or draw and graphically edit control 
envelopes for pluggo effects parameters. 

To Record Your Actions:

• In the audio mixer (either the Environment or Track Mixer window), choose the 
channel with the plug-ins you want to automate and change the Automation Mode of 
the channel to Touch, Latch, or Write. Touch will write only new changes, Latch will 
write only new changes and it will replace existing automation data after changes are 
made, and Write always overwrites existing automation data. Touch is the easiest and 

Versions of Logic Audio prior to 5.0 used the A-Playback channel (displayed 
between the Audio and MIDI channels in the song window) to record automated 
mixdowns. Pre-5.0 versions of Logic Audio do not store the initial position of a 
plug-in’s controls when you start recording. Use the Touch Parameters command 
in the pluggo plug-in Parameter Change pop-up menu when working with earlier 
versions of Logic Audio; the command sends out the plug-in’s current values to 
the host sequencer. and allows you to start your automation sequence from a 
known state.
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safest mode but see the Logic manual for more distinction between the different 
modes.

• Open the edit window for the plug-in you want to automate by double-clicking the 
name of the plug-in on the audio channel.

• Start the sequencer and move any parameter on the plug-in’s edit window. All 
changes made to the plug-in are recorded now. If you set Logic to cycle, you can 
record different parameter changes that will be merged with the previous ones. All 
the automation you have recorded can be viewed in the Arrange window when you 
choose to view Track Automation. 

• To create automation or to edit the already recorded automation data of the Pluggo 
plug-ins in the Arrange Window first activate the Track Automation from the View 
menu. If you click in the space below the Track Name you will see a list of the available 
plug-ins to automate and all of their parameters in submenus. If you have already 
written some automation, the plug-ins and the parameters with automation data will 
appear in bold type at the bottom of that menu. This menu lets you choose which 
parameter you are viewing.

Keep in mind that the automation is recorded whether or not Logic’s transport is 
in record mode. The Track Automation Modes are what toggle the recording of 
the automation. If you have finished automating the plug-in you can set the Auto-
mation Mode to Read. 
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Below the name of the plug-in and the parameter you see the automation mode and 
also the value of that parameter at the current cursor position in your track.

• To see more than one automated parameter at a time, click on the small triangle in 
the lower left-hand corner of the track info display to expand the view. You will see a 
separate track containing the recorded automation data for any other recorded 
parameter changes displayed below.
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• To edit the automation data you can use the Pencil tool to draw in value changes, the 
Eraser tool, or the Select/Curve tool to select and move, copy or delete blocks of auto-
mation data.

Automation in Pro Tools

Pro Tools lets you automate effects parameter changes in two ways. First, you can insert 
and graphically edit control envelopes for pluggo effects parameters, and second, you can 
record fader changes in real time. The menus you use to enable and set up effects auto-
mation are available in Pro Tools’ Mix and Edit windows and in the edit window of any 
effect. In the following examples, we’ll show you how to add effects automation from the 
Edit Window, and from the front panel of a plug-in.

To Add an Effects Control Envelope: 

In this example, we'll add an automated envelope to control the Feedback Gain of the 
pluggo Generic Effect plug-in to a track that we’ve already recorded. We'll assume Generic 
Effect has already been inserted in audio mixer channel 1, and that we've already found a 
sound we like.

• Make sure that automation for plug-ins is write-enabled in the Automation Enable 
window. When plug-ins are write-enabled, the button for plug-ins is selected.
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• Click on the auto button on the front panel for your plug-in to open the Plug-In 
Automation window. The Plug-In Automation window will list all of the automatable 
parameters for the plug-in you are using.

• Choose one or all of the plug-in parameters from the list and click on the Add button 
to enable the parameters. Click the OK button to close the window.

• To create a snapshot of the current parameter settings of your pluggo effect, rewind to 
the beginning of the audio track using the Transport Control. 
Plug-in Automation 96



• Hold down the command key and click in the plug-in’s edit window to see the 
Parameter Change pop-up menu. Choose Touch Parameters. All of the current set-
tings for this plug-in will be written at the beginning of the track.

• In the Edit Window, click on the Track Display Format selector for your track and 
choose the parameter from the pop-up menus.

• The Feedback Gain parameter will be highlighted on the audio track display, and the 
position of the parameter you selected will be displayed on your audio track. 

 You can add new breakpoints to your effects envelope by positioning the cursor on the 
current line and clicking.
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• You can change the envelope values at a breakpoint by clicking and dragging the 
breakpoint (when you click on a breakpoint and drag, the cursor changes to an X). 
Add and adjust new breakpoints until you are satisfied with the results.

You can add, delete, or edit breakpoints in your effects envelopes in several ways in 
Pro Tools. For more information, see the “Automation” chapter of the Pro Tools Ref-
erence Manual.

To Listen to Your Actions:

• Click on the Play button on the Transport Control to hear the amount of Feedback 
Gain change.

To Record Your Actions: 

You can also record pluggo effect parameter changes in real time. In this example, we’ll 
record some changes to the Feedback Gain of the Generic Effect plug-in on a previously 
recorded track.

• As shown in the previous effects control envelope example, make sure that automa-
tion for plug-ins is write-enabled in the Automation Enable window. Click on the 
auto button on the front panel of your plug-in to open the Plug-In Automation win-
dow, and select the parameter(s) you want to record.

• Click on the Record Enable button on the channel strip for the audio track whose 
plug-in parameters you want to record, and choose an automation mode. For this 
example, we'll use Auto Latch. Each of the automation modes is described in detail in 
the “Automation” section of the Pro Tools Reference Manual.
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• To record your parameter changes, Click on the Play button in the Transport Win-
dow. Note that to record effects changes for automation, you don’t need to use the 
Record button. 

Move the Feedback gain slider as the track plays. If you are using Auto Latch mode, 
you will record each parameter change every time you listen to the track and move 
the faders (i.e., you’re “overdubbing” effects changes). If you use Auto Write mode, 
each pass will erase the all effects changes you added before. Play and record your 
effects changes until you’re satisfied.

• To see the parameter changes you’ve recorded, click on the Track Display Format 
selector for your track and choose the parameter you want to view from the pop-up 
menus. 

You’ll see a representation of the track(s) you’ve inserted or recorded.
99 Plug-in Automation 



Troubleshooting
Here are some of the questions that our Technical Support department receives fre-
quently. In the event you encounter difficulties, we hope that these questions and their 
answers will be of some help to you.

Of course, we can’t answer every possible question here. We maintain a Frequently Asked 
Questions page on the Cycling ’74 website located at http://www.cycling74.com/sup-
port/questionspl.html where you can find more up-to-date information. You can also 
contact our Technical Support department by emailing support@cycling74.com.

Installing Pluggo

I use three different VST-compatible sequencers. Do I need to have three separate copies of all 
the files used by pluggo and all the plug-ins? That will use up a lot of disk space.

Only the plug-in files are in an application-specific place. The common files used by all 
pluggo host applications are located in the Max/MSP Runtime Support folder inside 
the Extensions folder. This folder should not be moved or renamed.

What are all those files in the Max/MSP Runtime Support folder?

Those are Max and MSP objects, best thought of as the building blocks out of which 
the plug-ins are made.

Do I have to delete my old plug-ins before installing the new version?

The Pluggo 3 installer will update the standard set of plug-ins. If you have Pluggo plug-
ins from other sources, they will not be deleted, but they will need to be updated before 
they will work in Pluggo 3. Contact the author of the plug-in for information on an 
updated version.

Authorization and Licensing Pluggo

The directions say to use the Authorize Pluggo application to enter my authorization code, 
but I can’t find the application.

Try using the Find... command in the Finder to look for the file. As stated in this man-
ual, it’s in the Pluggo Stuff folder, which is located wherever you told the Pluggo 
Installer to put it, normally in the root directory of the disk you selected for installa-
tion.

What happens if I lose my authorization code?

In theory, you only need the authorization code if you want to install pluggo on a sec-
ond computer (see the question below). As long as you have registered with Cycling’74, 
we have a record of your serial number and Registration ID. If you have already 
installed pluggo successfully on a particular machine, you can run Authorize Pluggo 
and see your Registration ID and serial number. If you register with Cycling ’74 at 
http://www.cycling74.com/register and give us these two pieces of information, we can 
give you a new authorization code.
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If I use several sequencing programs on the same hard disk, will I need to authorize pluggo to 
run with each one?

No, the authorization covers any and all installations on a particular computer, as long 
as the disk on which you authorized is mounted when you use pluggo.

General Questions about Working with Pluggo

Every minute or so, the audio output of my plug-in turns off and the level meter turns blue. 
What’s going on?

To stop this from happening, you need to enter your authorization code. The Authorize 
Pluggo chapter of this manual tells you how to do it.

 I can only use three of the pluggo plug-ins on my computer before everything starts to slow 
down a lot. Can you help?

Signal processing on your computer takes a lot of the CPU. pluggo plug-ins vary in how 
much processing time they will use. The pluggo Plug-in Reference Guide uses an adjec-
tive from light to heavy for each plug-in to characterize roughly how processor-inten-
sive a plug-in is likely to be.

Is there any way to undo editing a parameter in a plug-in’s edit window?

Yes. Command click in any pluggo edit window, and you’ll get a pop-up menu with 
Undo and a bunch of other fun things such as a Randomize command and the ability 
to copy the settings from any other effect program into the current one.

Using the command-click pop-up menu, I chose 6. Hello From Jail from the Copy from Pro-
gram submenu. But I’m still on Preset 1, and the name of the preset is still Car Bomb. That 
seems like a bug.

Copy from Program only the copies the values of the parameters in the preset you 
choose from the submenu. The number and name of the current program remain 
unchanged. In fact, these cannot be changed by the plug-in without leaving the user 
interface of the sequencer in an inconsistent state.

I inserted the pluggo plug-in and opened another plug-in that wasn’t in the VstPlugIns folder. 
I wanted to switch to another plug-in that I open with pluggo, so I picked pluggo from the 
sequencer’s effect menu again. Nothing happened. Why do I have to choose No Effect first?

The sequencer’s effect menu was not designed for “wild card” plug-ins like Pluggo that 
can open lots of different plug-ins. So when you pick it again, it’s as if you told the 
sequencer, “I don’t want to change the effect I’m using.”

I inserted the Mouse Mod (Key Triggers, Audio2Control, Breakpoints, etc.) plug-in but I 
don’t hear it doing anything.

These plug-ins are pluggo Modulators that generate information used to control other 
plug-ins. You choose the other plug-in from the Assign pop-up menus contained 
within the Modulator plug-ins. Modulators pass their audio inputs to their outputs 
unchanged.
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Hosting VST Plug-ins with Pluggo

What versions of VST will work with pluggo 3? Some of the free ones on the Internet are 1.0.

pluggo supports 1.0 and 2.0 plug-ins. 2.0 features supported include MIDI and host 
timing synchronization.

I have downloaded some free VST plug-ins. There are some though that won’t appear in Dig-
ital Performer 2.61. They have this under them “BlueGate VST .dll”. Is this because they are 
for PC instead of Mac?

Yes, anything that ends in .dll sounds suspiciously like a PC file.

Are there any limitations with using VST plug-ins in Digital Performer?

A few. A current list of plug-ins that are known to work and not work are listed in a file 
called Read Me Before Installing that is  a part of the pluggo installation package. If you 
find a plug-in that doesn’t work, please e-mail us and we’ll see if we can fix pluggo to 
make it work.

Using Logic with Pluggo

Every pluggo plug-in I try to load with Logic Audio gives me an AV error when I try to play 
something back.

You probably need to allocate more memory to Logic Audio. In the Logic manual it 
says that you need 15 to 20 MB to use realtime effects. But we think 25MB is more like 
it. On 601 and 603 processors, which we don’t recommend, Logic could simply be out 
of CPU resources. We do not recommend pluggo for these processors.

I can’t get the Host sync mode to work Logic 4.1

That’s because you need Logic 4.8.1 or later to use host synchronization.

I inserted the Mouse Mod (Key Triggers, Audio2Control, Breakpoints, etc.) plug-in on a ste-
reo channel in Logic, but now the channel is mono. If it isn’t doing anything to the audio (see 
question above), why is the output mono now?

You probably picked the mono-to-stereo version of Mouse Mod (listed in the menu as 
“Mouse Mod (m/s)”) rather than the stereo-to-stereo version. Logic monos the stereo 
channel before passing it to the plug-in in this situation. Choose the stereo-to-stereo 
version and your mixer channel will remain stereo.

I can’t send any MIDI controllers to Logic Audio to control my Instrument plug-ins that 
receive MIDI.

Logic does send controller 1 (mod wheel) and 64 (sustain) to the plug-in.

All other controllers are used for the return, meaning after the plug-ins, this is the 
audio object or channel itself. There control 7 (volume) and 10 (pan) and a lot of oth-
ers are used. Controllers after 64 are used to automate the plug-in controls.
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Using Digital Performer with Pluggo

 I can’t get the plug-ins to show up in my Mixing Board menu in Digital Performer/Performer.

Here are the requirements for pluggo in MAS to get the plug-ins to show up:

• You need to be using MOTU Audio System 2.1 or later. Check the version of the file in 
System Folder:Extensions:MOTU.

• Pluggo for MAS must be contained in System Folder:Extensions:MOTU:Plug-ins.

• You must be running Digital Performer 2.5 or later or Performer 6.0 or later.

• The MaxPlugLib, VstPlugLib, and Max Audio Library for Plugins files must be in the 
Extensions folder.

• The VstPlugIns folder must be in the same directory as the host application, with at 
least one plug-in file inside it.

• Files must be in the Max/MSP Runtime Support folder in the Extensions foler.

The timing properties of the synths (i.e., sloppy) concern me. Even when I bounced to disk, 
the non-realtime nature of which I imagined would result in perfect timing, the results were all 
over the place. What’s the score on this?

The timing resolution of VST Instruments in Digital Performer is related to the buffer 
size used by MAS.
103 Troubleshooting 



Index
A
ASIO output driver and Peak 18
Authorization and licensing pluggo 100
authorization code 8, 9
Autoload Song (Cubase) 12
automation

Touch Parameters 53
automation, 84

B
Beat Divider 71
breakpoint envelope editor 56
bus 81
bus effects 14

C
Carrier Source 81
changing effect parameters 51
changing effect programs

Cubase 31
Digital Performer 34
Live 37
Logic 38
Logic Audio 38
Max/MSP 40
Peak 42
Pro Tools 47
Spark 50

click track 69, 72
coarse mode 52
Copy All from Program 54
Create Set 62
creating a stereo audio channel

Digital Performer 14
Pro Tools 20

Cubase
assigning VST instruments 24
automated mixdown 84
changing effect programs 31
effect sends 14
insert effects 14
inserting mono plug-ins 13
inserting stereo plug-ins 13
master effects 10, 13
multiple processor hardware 13

plug-in edit window 32
Read button and automated mixdown

86
send effects 10
VST channel mixer 84
VST instruments 24
Write button and automated mixdown

84
Custom Install 6

D
demo mode 8
Digital Performer

assigning virtual instruments 27
automated mixdown 84, 86
automated mixdown playback 90
changing effect programs 34
creating a stereo audio channel 14
creating parameter setting snapshots

88
effects control envelope 86
FreeMIDI and OMS 26
hosting MAS plug-ins 76
hosting other VST plug-ins 76
inserting mono plug-ins 15
inserting plug-ins 14
inserting stereo plug-ins 15
multiple processor hardware 14
plug-in edit window 33
reading VST effect presets 35
recording effects changes 90
troubleshooting 103
updating the plug-in list 61
virtual instruments  25

Disable hints,Enable hints 56
disabling plug-ins 60
disabling plug-ins in a folder 64

E
Easy Install 6
edit window 77
effect programs 4

copying 54
effect sends (Cubase) 14
enabling plug-ins 60
Index 104



Evolve All 53

F
FAQ web page 100
filter graph 56
free synchronization mode 65, 68

G
gain slider 55
Generic Effect 74

H
hints

enabling and disabling 56
horizontal slider 55
host synchronization mode 65, 66
hosting MAS plug-ins 76

I
insert effect 10
inserting plug-ins 10

Digital Performer 14
Live 16
Logic Audio 16
Max/MSP 18, 29
Peak 18
Pro Tools 20
Spark 22

installation 6

L
level meter 57
LFO 74
license agreement 6
Live

changing effect programs 37
inserting plug-ins 16
plug-in edit window 36
x-y controller setting 37

Logic
changing effect programs 38
multiple processor hardware 14, 16

Logic Audio
assigning virtual instruments 28
automated mixdown 84, 92
bus channel 17
bus effect 17
changing effect programs 38
generic plug-in interface 39
insert effect 17
inserting plug-ins 16
mixer channel 17

plug-in edit window 39
Touch Parameters command 92
troubleshootings 102
virtual instruments 28

Logic audio
sending MIDI to plug-ins 102

M
Manage submenu 62
MAS

hosting MAS plug-ins 76
hosting other VST plug-ins 76
plug-in folder 58

MAS troubleshooting 103
master effects (Cubase) 10, 13
Max 4, 5
Max/MSP

changing effect programs 40
inserting plug-ins 18, 29
plug-in edit window 39

Max/MSP Runtime Support folder 6, 100
Messages view 54
MIDI

assigning virtual instruments 24, 27, 28,
30

mixdown automation
Cubase 84
Digital Performer 86
Logic Audio 92
Pro Tools 95

modulators 74
and audio input 74

mono plug-ins 12
Mouse Mod 74, 79

Assign menu 75
Mode menu 75
output range 75

MSP 4, 5
inserting plug-ins 18, 29

multi-channel plug-ins 12
Multiple processor hardware

Cubase 13
Digital Performer 14
Logic 14, 16

multislider 55
My Plug-in Set 62

N
naming plug-in sets 62
105 Index 



nested plug-in folders 62
New Folder for plug-ins 62
North Pole filter plug-in 78
note-unit multiplier 67
note-unit pop-up menu 67
Number Box 55
number box

changing parameters 52

O
opening a sequencer document 12

P
Parameter Change pop-up menu 56
parameter sliders

coarse mode 52
parameters

changing 51
changing numerically 52
modulating 74, 78
nudging 53
pop-up menu 52
Randomize All 53
undoing changes 53

Parameters view 54
Peak

ASIO output drive 18
batch processing soundfiles through

plug-ins 44
changing effect programs 42
inserting plug-ins 18
inserting Vbox plug-ins 19
processing audio files through plug-ins

43
recording audio files through plug-ins

43
using Vbox 19
Vbox plug-in routing 20

plug synchronization mode 66, 69
Pluggo Dictionary file 12
Pluggo FAQ 5
Pluggo for MAS plug-in 6
Pluggo Info view 54
Pluggo Installer 6
Pluggo plug-in 12, 76

loading MSP patches 77
loading non-pluggo plug-ins 77
modulating non-pluggo plug-ins 77

Pluggo Plug-in Reference Guide 4, 12

pluggo registration web page 100
Pluggo Stuff 6
Pluggo Stuff folder 72
Pluggo Support folder 6
PluggoBus 81
pluggoBus

input level 82
sources 83
synchronization 83

PluggoBus Rcv 82
PluggoBus Send 82
Pluggo Plug-ins folder 10, 58
Pluggo-RTAS plug-in 6
PluggoSync 65, 66, 69, 71
plug-in

edit window in Cubase 32
edit window in Digital Performer 33
edit window in Live 36
edit window in Logic Audio 39
edit window in Max/MSP 39
edit window in Pro Tools 46

plug-in folder 60, 62
plug-in folders

nested 62
Plug-in Manager 58

creating subfolders 63
disabling plug-ins 64
viewing plug-in folders 63

plug-in sets
naming 62
recalling 62
saving 62

plug-ins
automating 84
diagnostic messages 54
edit window 31
enabling and disabling 60
getting info about 62
inserting 10
inserting mono 15, 21
inserting stereo 12, 15, 16
modulation 74
mono, stereo, multi-channel 12
settings in Digital Performer 34
settings in Pro Tools 47
updating the plug-in list with MAS 61
version information 62
Index 106



plugs
getting information about 54

pop-up menu
parameter change 53

pop-up menus 52
Interface view 56

pre-fader send 72
Pro Tools

assigning virtual instruments 30
automated mixdown 95
automated mixdown playback 98
changing effect programs 47
creating a stereo audio channel 20
dual-mono effects 48
effects control envelope 95
inserting mono plug-ins 21
inserting plug-ins 20
plug-in edit window 46
recording effects changes 98
virtual instruments 30
VST hosting disabled 76

R
Randomize All 53
range slider 55
recalling plug-in sets 62
Registration ID 8
repetitive strain injury 74
RTAS

hosting other plug-ins 76
plug-in folder 58

S
saving plug-in sets 62
send effects (Cubase) 10, 13
Spark

bypassing effects programs 51
changing effect programs 50
inserting plug-ins 22
plug-in routing 23
processing audio files through plug-ins

51
stereo effects 22

startup 12
stereo plug-in insertion 12
stereo plug-ins 12
sync mode menu 66
sync.aiff audio file 72

synchronization
of pluggoBus audio 83

synchronization mode
free 65
host 65
plug 66
UDT 66

synchronization modes 65
free 68
host 66
plug 69
UDT 68

synchronizing plug-ins 65
System Requirements 5

T
technical support 5
Tempo/Sync parameter 66
toggle box 55
Touch Parameters 53
Troubleshooting 100

Digital Performer 103
finding the Authorize Pluggo applica-

tion 100
hosting VST plug-ins 102
Logic Audio 102

troubleshooting
MAS 103

U
UDT synchronization mode 66, 68
Undo 53
Undo Last Change 53
user interface elements 55
user-defined tempo 68

V
Vbox

as pluggo application 19
inserting plug-ins 19
plug-in routing 20

vertical slider 55
View pop-up menu 54, 78
viewing plug-in folders 63
107 Index 



virtual instruments
assigning MIDI 24, 27, 28, 30
FreeMIDI and Digital Performer 25
IAC bus connections in Digital Per-

former 25
Logic Audio 28
Pro Tools 30

Vocoder 81
VST instruments

Cubase 24
VST instruments,MIDI

VST instruments 24
VstPlugIns folder 10, 12, 58, 77, 79
VstPlugIns folder,Pluggo Plug-ins folder
58

W
Web pages

FAQ 100
registering pluggo 100
Index 108


	Table of Contents
	Copyright and Trademark Notices
	Introduction
	About This Manual
	Basic Features of Pluggo
	System Requirements
	Where to Get Help and Support
	A Little Background Information on Pluggo

	Installing Pluggo
	What is Going to be Installed?
	The Pluggo Installer

	Authorize Pluggo
	Entering Your Code

	Inserting Plug-ins Within Your Sequencer
	Is Pluggo Asking for a Plug-in?.
	Inserting Plug-ins—Mono, Stereo, or Multi-Channel
	To Make a Stereo Insertion in Cubase:
	To Make a Mono Insertion in Cubase:
	To Make an Insertion in Live:
	To Make an Insertion in Logic Audio:
	To Make an Insertion in Max/MSP:
	To Make an Insertion in Peak:
	To Make an Insertion in Pro Tools:
	To Make an Insertion in Spark:


	Using Virtual Instruments
	To Use a Virtual Instrument in Digital Performer:
	To Route a MIDI Track to the Virtual Instrument in Digital Performer:

	To Use a Virtual Instrument in Logic Audio:
	To Use a Virtual Instrument in Max/MSP:
	To Use a Virtual Instrument in Pro Tools:
	To Route a MIDI Track to the Virtual Instrument in Pro Tools:


	Using Virtual Instruments
	To Use a Virtual Instrument in Cubase:
	To Route a MIDI Track to the Virtual Instrument in Cubase:

	To Use a Virtual Instrument in Digital Performer:
	To Route a MIDI Track to the Virtual Instrument in Digital Performer:

	To Use a Virtual Instrument in Logic Audio:
	To Use a Virtual Instrument in Max/MSP:
	To Use a Virtual Instrument in Pro Tools:
	To Route a MIDI Track to the Virtual Instrument in Pro Tools:



	Using the Plug-in Interface
	Using the Plug-in Interface in Cubase:
	Using the Plug-in Interface in Digital Performer:
	Reading VST Effect Documents into MAS Presets

	Using the Plug-in Interface in Live:
	Using the Plug-in Interface in Logic Audio:
	Using the Plug-in Interface in Max/MSP:
	Using the Plug-in Interface in Peak:
	Applying Plug-ins to an Audio File in Peak
	Batch Processing with VST Plug-ins in Peak

	Using the Plug-in Interface in Pro Tools:
	Using Built-in Presets in Pro Tools
	Using Dual-Mono Effects in Pro Tools
	Using AudioSuite plug-ins in Pro Tools

	Using the Plug-in Interface in Spark:
	Changing Parameters
	Applying Plug-ins to a Audio File in Spark
	Changing Parameters

	The Parameter Change Pop-up Menu
	Using the View Menu
	Elements of Interface Views
	Interface Hints and Labels

	Plug-in Manager
	Starting Plug-in Manager
	Enabling and Disabling Plug-ins
	When Are the Files Moved?
	Getting Information About a Plug-in
	Saving Plug-in Sets
	Working with Multiple Plug-in Folders
	Working with Nested Plug-in Folders

	Synchronizing Plug-ins
	Opening the Sync Example Document
	Exploring the Synchronization Modes
	Host Mode
	Free Mode
	UDT Mode
	Plug Mode
	Using PluggoSync

	Feeding Audio to PluggoSync

	Using Modulator Plug-ins
	Using Other VST Plug-ins within Pluggo
	Using Other VST Plug-ins within MAS
	The Pluggo plug-in
	Features of Hosted Plug-ins
	Modulating the Parameters of a Hosted Plug-in

	Getting On the PluggoBus
	PluggoBus Receivers
	PluggoBus Senders

	Plug-in Automation
	Automation in Cubase
	To Record Your Actions:
	To Listen to the Actions You’ve Recorded:

	Automation in Digital Performer
	To Add an Effects Control Envelope:
	To Listen to Your Actions:
	To Record Your Actions:

	Automation in Logic Audio
	To Record Your Actions:

	Automation in Pro Tools
	To Add an Effects Control Envelope:
	To Listen to Your Actions:
	To Record Your Actions:


	Troubleshooting
	Installing Pluggo
	Authorization and Licensing Pluggo
	General Questions about Working with Pluggo
	Hosting VST Plug-ins with Pluggo
	Using Logic with Pluggo
	Using Digital Performer with Pluggo

	Index

